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IMPORTANT SAFETY INFORMATION

SYMBOLS AND TERMS
DANGER
Practices or circumstances that can lead to death or catastrophic property damage or eco-
nomic loss.

WARNING
Practices or circumstances that can lead to serious personal injury, property damage, or 
economic loss.

ELECTRICAL SHOCK WARNING
An electrical hazard which will result in personal injury if instructions are not followed.

CAUTION
A hazardous situation which can lead to minor or moderate injury, property damage, or 
economic loss.

Important Non-urgent information that may impact the outcome of a process or procedure.

Note Additional information or a tip that may help the user to work more efficiently.

DO NOT DISCARD IN TRASH CAN
Product should not be discarded as unsorted waste. It must be sent to separate 
collection facilities for recovery and recycling.

CONTACT SENSIA
For technical support, please refer to https://www.sensiaglobal.com/Technical-Support.
For all other inquiries, please refer to https://www.sensiaglobal.com/Customer-Care or dial 1-866-773-6742.

REVISION HISTORY
Revision Description of Change Issuer Approver Date

01 Release to production KM TMM 6-7-2023

https://www.sensiaglobal.com/Technical-Support
https://www.sensiaglobal.com/Customer-Care
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PUBLISHER NOTES

DISCLAIMER
While Sensia has taken every care in the preparation of this document, it cannot accept responsibility for 
printing errors or omissions and does not warrant that it is correct and comprehensive in every particular in-
stance. Equipment supplied should always be operated by persons with an appropriate level of skill and train-
ing. 
Sensia shall not be liable for incidental or consequential damages resulting from the furnishing, performance 
or use of this material.
Sensia pursues a policy of continuous improvement, and information given herein may be updated without 
notice. Further, this information is proprietary to Sensia, and must not be disclosed to any third party except 
as may be required to operate the equipment supplied in accordance with the purposes for which it was sold 
by the persons properly licensed to operate it.

COPYRIGHT NOTICE
Copyright © 2023 Sensia. All rights reserved. 
This work contains the confidential and proprietary trade secrets of Sensia and may not be copied or stored 
in an information retrieval system, transferred, used, distributed, translated or retransmitted in any form or by 
any means, electronic or mechanical, in whole or in part, without the express written permission of the copy-
right owner.

TRADEMARKS & SERVICE MARKS
An asterisk (*) is used throughout this document to designate marks of Sensia. Other company, product, and 
service names are the properties of their respective owners. 
Sensia, the Sensia logotype, and other words or symbols used to identify the products and services described 
herein are either trademarks, trade names or service marks of Sensia and its licensors, or are the property of 
their respective owners. These marks may not be copied, imitated or used, in whole or in part, without the ex-
press prior written permission of Sensia. In addition, covers, page headers, custom graphics, icons, and other 
design elements may be service marks, trademarks, and/or trade names of Sensia and may not be copied, 
imitated, or used, in whole or in part, without the express prior written permission of Sensia.

WARRANTY
Product warranty is specified in Sensia Terms and Conditions at the time of purchase.

SECURITY NOTICE FOR SOFTWARE PRODUCTS
The software described herein is designed to operate with the minimum hardware and operating system 
specifications recommended by Sensia. The software should be operated in a secure environment whether 
operation is performed across a network, on a single system and/or on multiple systems. 
The end user is responsible for configuring and maintaining networks and/or system(s) in a secure manner. 
The end user is also responsible for obtaining, installing, operating and maintaining all hardware, other equip-
ment and third party software required for use of the software. Sensia is not responsible for data loss arising 
as a result of software use or interaction of the software with any third party software. 
For more information about recommended security practices, please contact Sensia Technical Support via 
https://www.sensiaglobal.com/Technical-Support.

https://www.sensiaglobal.com/Technical-Support
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Section 1: Getting Started

INTRODUCTION
The NUFLO* MC Synergy* Software is downloadable from the Sensia website and allows you to configure 
the MC Synergy, calibrate inputs, download logs, and view data. 
In fact, it gives you two ways to configure a device:
1. You can upload configuration settings while your PC or laptop is actively connected to the device. 
2. You can create or edit configuration settings offline without a device connection and save them to a pro-

prietary file that can be stored on a computer and imported into devices as needed.
PC software is one of four interface options available for the MC Synergy totalizer and has the most exten-
sive set of configurable options. Other interfaces include the local keypad menu, a Bluetooth app that can be 
downloaded to a smart phone or tablet, and with the purchase of an expansion board, HART communications. 

COMMUNICATIONS WIRING
To connect to an MC Synergy, you will need the following cables/converters:

• An RS-485 communications converter assembly that connects to one of the MC Synergy's RS-485 ports 
and provides an RS-232 or USB connector on the other end

• For connecting to a PC or laptop USB port, a USB A/B communications cable is also required.

In a non-hazardous area, the converter assembly can be installed on an EXP model with the enclosure cover 
removed, or installed in a WP model by routing the cable through a conduit in the bottom of the enclosure. 
To establish a USB connection in an EXP device without removing the cover, see USB Connection for EXP 
Model below. Converter assemblies and USB cables are available from Sensia.
For complete installation information, see the MC Synergy EXP and WP Hardware User Manuals.

USB CONNECTION FOR EXP MODEL
The NUFLO USB Adapter allows a user to connect a computer to the MC Synergy EXP using a standard off-
the-shelf USB connector cable for quick and easy downloads without opening the MC Synergy enclosure. A 
customer-supplied universal USB cable is required to connect the NUFLO USB adapter to a computer. 
To complete the installation, you will install a required driver available from the Sensia website. See Installing 
a USB Adapter Driver, page 10 for details.
Instructions are also supplied in the NUFLO USB Adapter Installation Guide, which is included in the software 
download selections on the Sensia website.

INSTALLING SOFTWARE AND DRIVERS
The latest user interface software is available for download on the Sensia website. Use this procedure to 
download and install the program.
1. Download the MC Synergy Software install file as follows:

a. Navigate to the Sensia website in your web browser: https://sensiaglobal.com/Measurement.
b. Choose Turbine Flow Electronics tile from the product grid.
c. Choose the NUFLO MC Synergy device.
d. Scroll to Product Resources and click Software.
e. Click the Download link for MC Synergy software to download install files to your computer.
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Note Before exiting the Software web page, review the contents and download any other software 
or drivers you may require, such as the ScanData software for viewing archive data or the USB 
adapter driver.

2. Browse to the “NUFLOMCSynergyInterfaceSoftware.zip” folder on your computer, right-click, select Ex-
tract All, and select a location for the extracted files. To automatically open the folder containing extracted 
files, check the box next to “Show extracted files when complete.”

3. Launch the Setup.msi file to initiate installation. 
4. Follow the onscreen prompts, editing the program folder if desired. By default, program files will be stored 

at C:\Program Files (x86)\Sensia\MC Synergy Interface.
5. When the installation is complete, a MC Synergy icon (Figure 1.1) will appear on the desktop and the MC 

Synergy software will appear under the START menu of your PC or laptop.

Figure 1.1—MC Synergy desktop icon

INSTALLING A USB ADAPTER DRIVER
If you are using a NUFLO USB Adapter to connect to your MC SYNERGY EXP device, use the following pro-
cedure to install the required driver.
1. Disconnect the USB adapter from your computer, if connected. 
2. Download the driver from the Sensia website as described in step 1 of the above software installation 

procedure.
3. Extract the contents of the zip file and click setup.htm.
4. Click Install USB Driver to install the NUFLO USB Adapter driver, following on-screen instructions.



NUFLO MC Synergy Software  Section 2

11

Section 2: Connecting to a Device
When you connect to your MC Synergy device, you can view device status including alarm conditions, config-
ure the device, apply calibration data from the companion flow meter, download device history, and perform 
necessary maintenance. 

Important You do not have to be connected to a device to create or edit configuration settings. See Config-
uring a Device Offline, page 35 for instructions on building a configuration file offline.

CONNECTING TO THE MC SYNERGY
Before attempting to run the interface software, verify that the MC Synergy is connected to a computer with 
an RS-485 to USB converter or a NUFLO USB adapter. See the MC Synergy Hardware User Manual for de-
tails.
1. Open the MC Synergy software and press Connect to Device on the Home page (Figure 2.1).

Figure 2.1—Home page

2. Choose one of three connection methods, depending on your needs:

 – Recent Connections. The window will list the parameters of the most recently connected devices. 
This is a good choice if you regularly connect to the same MC Synergy using the same COM port, 
baud rate, and slave address. 

 – Express Connect. This selection scans for connected devices on the specified COM port and 
attempts to connect to the device. The software automatically determines the communication settings 
including baud rate and slave address. This connection type is best used when you are connected to 
only one MC Synergy device.

 – Specify Parameters. This selection allows you to enter custom parameters for serial communication 
over the COM port. This is useful when you are connected to several MC Synergy devices on a single 
RS-485 network. Each MC Synergy must have a unique slave address. This is a good choice for 
troubleshooting  device connectivity while manually changing parameters on the MC Synergy keypad 
(see the MC Synergy Hardware User Manual for details).
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Figure 2.2—Recent Connections screen

Figure 2.3—Express Connect screen
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Figure 2.4—Specify Parameters screen

When the software locates the MC Synergy device and begins the connection, the main screen will appear 
and blue progress bars can be observed in the framed navigation window at the top of the screen and at the 
bottom of the screen.

Figure 2.5—Progress bars confirm a connection in progress
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CHANGING DEFAULT CONNECTION SETTINGS
If you repeatedly use a connection method other than the factory default Express Connect method, you can 
save steps by changing the connection default setting. See Change Default Connection Method, page 94, 
for details on changing this default setting.

TROUBLESHOOTING A CONNECTION FAILURE
A connection failure can be caused by a mechanical problem or incompatible software communication set-
tings. For help in detecting and correcting a problem, please review Appendix A—Troubleshooting Serial 
Communications, page A-1 for a list of some of the more common connection and communication issues  
and solutions. If you are unsuccessful in resolving your issue with these suggestions, contact a Sensia tech-
nician for assistance using the contact information provided in the Help>About menu in the software and on 
page ii of this manual.
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Section 3: Navigating the Software
Upon connecting with the MC Synergy, the software will display the main navigation screen shown in Figure 
3.1. Using the four navigation menus that appear as brightly colored tiles at the top of the screen, you can 
view, configure, and maintain all of the measurement functions supported by the MC Synergy.
Immediately above the navigation menus, a framed window provides a "you are here" reference to identify 
your location at any given time. It also provides positive identification of your connected device by displaying 
serial number, slave address, communications port details.
The content in the main body of this screen changes to reflect the menu (tile) selected. Upon connecting to 
the device, the view defaults to the Device Status screen shown below. Click the other tiles in the navigation 
menu to see how the screen content changes with respect to each menu selection.
This section provides an overview of the software interface to help familiarize you with basic navigation. Sec-
tions 4 through 8 then build on this content by exploring the functionality that is specific to each of four primary 
navigation menus.

Navigation window

Navigation menu

Menu bar

Figure 3.1—Key navigation features

The distribution of software features among four primary menus or functions allows you to instinctively choose 
a menu based on the feature or function you desire, navigate through related settings to configure your de-
vice, and then upload your settings to a connected device.
From any of these four main screens, you can disconnect from your device by clicking Disconnect in the up-
per right corner of the screen.

DEVICE STATUS
This menu provides a snapshot of current configuration settings, real time flow rate and grand total volume, 
real time output values where applicable, alarms status, system/archives status and network status. This 
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screen can give important indicators for device health to help you quickly identify necessary maintenance for 
the connected device or turbine meter. 
Refresh the view as needed using the two Refresh options in the upper right corner of the screen. Click the 
Refresh link to refresh the screen on demand, or check the Auto-Refresh checkbox to enable a periodic re-
fresh.

CONFIGURE DEVICE
When the PC software connects to an MC Synergy device, the device configuration is automatically down-
loaded. To edit the configuration, enter new selections into the software interface and then click the Upload to 
Device button (Figure 3.2) to write the new settings to the device.

Figure 3.2—Configure Device menu

From the Configure Device screen, you can perform four primary configuration functions using the gray tabs 
with icons located just below the colored navigation menu:

• Upload configuration settings to a device
• Re-read configuration settings from a device
• Import configuration settings from a saved configuration (SRF) file
• Save existing configuration settings to a local configuration file (SRF) for use in configuring other devices

UPDATING YOUR DEVICE CONFIGURATION
From the Configure Device screen, you will also see a grid of submenus grouped by three configuration 
types: System, Turbine, and Outputs (Figure 3.3). Clicking on any one of these grids will open a screen with 
related settings for your selection. 
See sections 5 through 7 for step-by-step instructions.  

Figure 3.3—Configuration sub-menus
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When you have completed your configuration, you can click Upload to Device to apply the settings immedi-
ately to a connected device.
Alternatively, you can configure device settings offline without a device connection and save the settings to a 
local SRF file that can be safely shared with others and used to configure field devices as needed. See Con-
figuring a Device Offline, page 35, for detailed instructions about offline device configuration. 

UNSAVED CHANGES ALERT
If you have entered configuration changes that were not uploaded them to the device, you will see a red Un-
saved Changes alert in the upper right corner of  the Configuration Menu screen (Figure 3.4).
You can view the unsaved changes by clicking View Change Report, located just below the alert. Inside the 
Change Report, click the Show Changed Fields Only link to filter the view to unsaved changes (Figure 3.5, 
page 18). This view exists only when there are UNSAVED changes.

Note If unsaved changes exist and you click anywhere other than the "Upload to Device" button, an 
Alert dialog will  appear to prompt a decision to save or discard the changes.

Figure 3.4—Unsaved Changes alert
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Figure 3.5—Change report filtered to show pending changes

DOWNLOAD ARCHIVES
The Download Archives menu allows you to download the stored archives from the device (Figure 3.6, page 
19). Files are saved in a secure non-editable SDF format that can be opened with Sensia's data analysis 
software, ScanData. 
Sensia offers two file naming conventions to help you manage your downloads and make them easier to re-
trieve. You may opt for the automated file naming scheme or arrange for a prompt to enter a custom file name 
after each download.
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Figure 3.6—Download Archive menu

MANAGE DEVICE
The Manage Device menu contains a variety of discrete functions that can be performed to manage and 
maintain the MC Synergy. They are grouped into four categories:

• Configuration Upload
• Device Commands

 – Sync Device Clock
 – Sync Device Clock with Offset
 – Clear Unacknowledged Alarms
 – Reset Grand Total
 – Create Partial Records
 – Reset Port Stats (typically for debugging)
 – Load Defaults
 – Reset Meter Kit Life (improved maintenance)

• Output Calibration
 – Calibrate Analog Output (set trim offset and scale for a 4 to 20 mA output)
 – Reset Analog Output Calibration

• Device Firmware Update
 – Upload Firmware Image
 – Activate Stored Firmware (if firmware is not activated at the end of upload)
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Figure 3.7—Manage Device menu

MENU BAR
A standard menu bar at the top of the interface provides an alternate access point for navigation and may 
be preferred in certain operating environments. It is accessible from every software screen. See Table 3.1—
Menu Bar, page 21 for a detailed summary of menu options and layout.
Section 11: Interface Options, page 93, further explores settings in the Tools>Options menu for helping you 
to fine-tune your user experience. You can change default settings to save steps in accessing the settings you 
use most often, change communications settings to aid in troubleshooting, and learn to set up rules for auto-
naming your archive files, for example.
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TABLE 3.1—MENU BAR
File Exit the software from any location.

Navigation From any of the four primary 
navigation menus, you can 
1) disconnect from the device or  
2) choose a different primary 
navigation menu.  
From submenus, you can return to a 
primary menu.  

Pages Appears only when the Configure 
Device menu is selected. Select any 
of the sub-menus shown to configure 
a specific function. 

Actions Available actions vary, depending on 
your location in the interface.

Tools Access advanced optional settings 
for device connection, communication 
and data archival.  
Access a snapshot of device ID 
information including hexadecimals, 
which may be of use in 
troubleshooting issues.

Help Access instructional manuals.
Verify the version of software 
components loaded (useful for 
troubleshooting). 
Click About for technical support 
contact info or to view the Sensia 
license agreement.
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Section 4: Device Status
The MC Synergy Device Status screen (Figure 4.1) provides a snapshot of the Device Status, Alarms Status, 
System and Archives Status, and Network Status. This top-level view gives indicators for device health and 
helps you quickly identify maintenance needs for the connected device or turbine meter.

Figure 4.1—Status screen

Important To force an update to your real-time device status data, use the two Refresh options at the top of the 
screen. Click the blue Refresh Link to refresh the screen on demand or check the Auto-Refresh checkbox 
to enable a periodic refresh.



Section 4 NUFLO MC Synergy Software

24

DEVICE STATUS
The Device Status screen (Figure 4.2) helps you to ensure that your connected device is up to date, the time 
is synced correctly, an expansion board (if present) is detected and operating as expected, the basic configu-
ration and input and output data is as expected, and periodic measurements are tracking properly. 
For more detailed information, download and view archive data (see Section 9: Download Archives, page 
81).

 
Figure 4.2—Device Status

• General. Shows firmware versions, device time and date (which attempts to synchronize with the 
computer time and date upon device connection), and acknowledgment of an expansion board if installed. 

• Turbine Flow Data. Shows device operation details. The flow rate, displayed as percentage of full scale in 
a speedometer type gauge, is calculated from the K-factor and meter factor (if configured). The flow rate 
and grand total units may be selected in the Configure Device tab (see Device Units, page 43).

• Configuration Settings. Shows the basic configuration present on the device. The active K-factor may be 
an interpolated value that is dependent on the input signal frequency from the turbine meter.

• Digital Output Data. Shows the configured output mode and an associated "state" or "value." 
 – When the output is a status output, the state of the output will display as a 1 (Activated/On) or 0 

(Deactivated/Off). 
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 – When the output is operating as a pulse output, the value represents the number of pulses remaining 
to be transmitted. A value of zero means that there are no pending pulses to be transmitted. Non-
zero values occur when the pulses are being sent out, but the flowing conditions, scale factor, and 
pulse duration have exceeded the time allotted between flow calculations. The MC Synergy caches 
these pulses to be transmitted. If the output cache value is large and not approaching zero, consider 
adjusting the pulse output scale factor and/or the pulse duration.

 – When the output is operating as Amplified Raw Output, the value will always show 0, which should be 
interpreted as "not applicable." 

• HART Output Data. Shows the current output values and variables being outputted from the device. The 
HART values will be zeroed if the HART expansion board is not installed, or if HART is not enabled.

• Periodic Measurement Data. Shows hourly, daily, and monthly trends for volume, run time, and user 
events.

ALARMS STATUS
The Alarms Status (Figure 4.3) gives a synopsis of the state of the current turbine, system, and user alarms 
that are enabled. To view the state of all alarms in a specific category, simply click the triangle icon next to the 
category (Turbine Alarms, System Alarms, or User Alarms) to expand the list, or click “Show All Details” at the 
right of the screen to expand all three alarm categories.

ALARM INDICATORS
The following graphical indicators are used to show alarm status.

General Health
The unlabeled column of symbols highlighted in Figure 4.3  is an indicator of general health that is viewable 
when the turbine, system, and user alarm lists are collapsed.

  An active alarm is present.

  An alarm is unacknowledged.

  Good health (no active alarms are present).

Figure 4.3—Alarms status, collapsed view
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Detailed Alarm Status
When an alarm list is expanded (Figure 4.4), the following indicators are used to show the status of individual 
alarm conditions.

  An active alarm is present.

  An alarm is unacknowledged.

  Good health (no active alarms are present).

Figure 4.4—Alarms status, expanded view

Acknowledging an Alarm
The Status column shows the current status of all configured alarms. When an alarm condition occurs, an 
alarm indicator will appear in the Status column and an Unacknowledged symbol  will appear in the Unack 
column. When the alarm condition has been serviced, click Acknowledge Alarms (Figure 4.3, page 25, up-
per right corner) to reset the status of the alarm. This will remove any Unacknowledged symbols associated 
with the parameter if no alarm conditions are present. If alarm conditions persist, the respective alarms will 
reactivate.
If the current Status is showing an Unacknowledged symbol , as in the example of BAT1 Voltage in Figure 
4.4, this is an indication that the parameter was in alarm previously but has returned to normal status without 
the alarm being acknowledged. In this case, the Unacknowledged symbol will be displayed in both the Status 
and Unack columns. Clicking Acknowledge Alarms should clear both symbols.
To clear all unacknowledged alarms in one step, go to the Manage Device tab (see Section 10: Manage De-
vice, page 85) and click Clear Unacknowledged Alarms. This action is useful when working with a techni-
cian to verify an alarm condition is no longer present.

Note Bent Blade, Missing Blade and Erratic Signal will not display the yellow Unacknowledged Alarm 
symbol in the Status column following detection of an alarm condition. Once the alarm is trig-
gered, the red Alarm symbol will be displayed in the Status column and the "Inst" (Instanta-
neous) column, and the Unacknowledged Alarm symbol will be displayed in the "Unack" column.  
The Alarm and Unack symbols will clear once the alarm is acknowledged. 

Suppressing Alarms

Important From the PC software, you can suppress the display of system, turbine, and user alarms in the 
local device display to minimize interruptions in the readout. This will not affect the way alarms 
are displayed in the software, in alarm logs, or in Enron reports. See LCD Display Settings, page 
52, for configuration information.
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TURBINE ALARMS
The Turbine Alarms status display gives you current status information for the connected turbine and a brief 
history of the turbine health over the current and previous interval, day, and month. This will either show “OK”, 
or indicate the number of alarms that have activated within the designated time period (hour, day, and month). 
To see the individual alarms activated, click the triangle icon to expand the Turbine Alarms view (Figure 4.5).

 
Figure 4.5—Turbine Alarms status

By default, the MC Synergy detects the following turbine alarm conditions. For a more detailed definition of 
these alarm setpoints, see the NUFLO MC Synergy EXP and WP hardware manuals. See also Turbine Meter 
Information, page 64.  

• T1 Low-Low Flow. Flow rate is significantly lower than the configured low flow range for the turbine meter.
• T1 Low Flow. Flow rate is below the configured low flow range for the turbine meter.
• T1 High Flow. Flow rate is above the configured high flow range for the turbine meter.
• T1 High-High Flow. Flow rate is significantly higher than the configured high flow range for the turbine meter.

CAUTION
High-High Flow Alert. Continuing in a critically high flow state may cause permanent damage to 
the turbine.

• T1 K-Factor Error. The entered K-factor calibration is invalid. See K-Factor Settings, page 66, to 
recalibrate.

• T1 Flow Stability Warning. The device has detected high fluctuations in the flow rate over an extended 
period of time (more than 10 seconds).

• T1 Meter Factor Error. The entered Meter Factor calibration is invalid. See Meter Factor Settings, page 
67, to recalibrate.

• Bent Blade. The device has measured a deflection greater than 2° from the turbine input signal. Ensure 
that the configured blade number is accurate, and check blade configuration before servicing the turbine 
meter.
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• Missing Blade. The device has detected a blade that is severely bent, washed out, or broken off. Ensure 
that the configured blade number is accurate and check blade configuration before servicing the turbine 
meter.

• Erratic Signal. The device has detected a signal that appears to be intermittent, noisy, or outside of 
expected parameters. An erratic signal may be due to damaged, loose, or faulty wiring, a damaged, 
loose, or faulty pick-up, or line noise. Increase the input threshold configuration if line noise is suspected. 
If this is ineffective, check for damaged, loose, or faulty wiring or pickup connection.

• Internals Kit Run Time. When the flow time of the turbine meter has reached the configured kit life, 
replacement of the kit is recommended. Replace the meter and reset the alarm by activating the Reset 
Meter Kit Life button in the Manage Device menu or selecting Replace Meter Kit in the turbine input menu 
of the local display menu. See the MC Synergy Hardware Manual for more information. The MC Synergy 
will respond by automatically setting the turbine meter life to the elapsed flow time recorded for the replaced 
turbine meter.

Note If you do not configure the expected kit life for a connected turbine meter, the meter kit life alarm 
will activate after 2 years of use. The configurable range for expected meter kit life (flow time) is 
1 to 3650 days.

SYSTEM ALARMS
The MC Synergy is designed with system alarms to alert you to conditions that could put the totalizer or a 
connected turbine meter at operational risk. System alarms trigger when the time has not been synced, or if 
the device is at risk of losing power. This display also provides a brief history of the MC Synergy over the cur-
rent and previous hour, day, and month. This will either show “OK”, or will indicate the number of alarms that 
have activated within the time period (hour, day, and month). To see the specific alarms activated, click the 
triangle icon to expand the System Alarms view (Figure 4.6).

Figure 4.6—System Alarms status

• Time Not Set. The clock battery has expired and the device has lost power, or the time on the device 
has not been set. When a connection is established with an MC Synergy device, the software will 
automatically sync the device time to the computer, unless you decline the prompt. To manually set the 
time using the keypad, refer to the MC Synergy Hardware Manual. If the time is set, the current value will 
show “0”.

• Supply Voltage. The supply voltage is below 6V or above 27V for at least 5 seconds. The alarm condition 
will persist until a low input voltage rises above 6.7V, or a high input voltage drops below 26.3V. If not 
in alarm, the current value will be shown. A high-high alarm will trigger at 33V and a low-low alarm will 
trigger at 5V.
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• Expansion Voltage. The Ethernet expansion board voltage is below 4V or above 16V for at least 5 
seconds. The alarm condition will persist until a low input voltage rises above 4.7V, or a high input voltage 
drops below 15.3V. If not in alarm, the current value will be shown.

• BAT1/BAT2 Voltage. Battery voltage is over 5V for at least 5 seconds. The alarm condition will persist until 
the battery voltage drops below 4.8V. If not in alarm, the current value will be shown. A high-high alarm 
will trigger at 6V.

• BAT1/BAT2 Percent. A low alarm will trigger when the battery life is less than 20% for at least 10 seconds. 
A low-low alarm will trigger when battery life is depleted to 10%. The device displays the percent reading 
using the automatic coulomb counter feature on the MC Synergy.

USER ALARMS
The MC Synergy includes eight user-configurable alarms which may be set to trigger an alarm based on a list 
of registers (see Alarms Setup, page 58 for configuration and additional information). The Alarms Status 
display (Figure 4.3, page 25) gives a synopsis of the user alarms that are enabled, including current status 
information and a brief history of the MC Synergy over the current and previous hour, day, and month. This 
will either show “OK”, or indicate the number of alarms that have activated within the time period (hour, day, 
and month). 
To see the specific alarms enabled, and which enabled alarms have been activated, click the triangle icon to 
expand the User Alarms view (Figure 4.7).

Figure 4.7—User Alarms status

Detailed User Alarm Status
When a user alarm list is expanded (Figure 4.7), the following indicators are used to show the status of  
individual alarm conditions.

  An active alarm is present.

  An alarm is unacknowledged.

  Good health (no active alarms are present).

  (Lo) The value of the configured item has dropped below the user-specified setpoint.

  
(LoLo) The value of the configured item has progressed beyond the primary low setpoint and dropped 
below a secondary user-specified setpoint.
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 (Hi) The value of the configured item exceeds the user-specified setpoint.

 
(HiHi) The value of the configured item has progressed beyond the primary high setpoint and exceeds a 
secondary user-specified setpoint.

SYSTEM AND ARCHIVES STATUS
The System and Archives Status (Figure 4.8) shows a snapshot of the device health and gives a summary of 
the memory usage for storing the daily, interval, event, and alarm records. This display may help explain why 
a device is not operating as expected, if a battery needs to be replaced, or if records need to be downloaded 
and cleared from a device in order to make room for more records.
If an archive reaches maximum capacity, older records will be overwritten by newer records. To preserve all 
records, you should periodically download the archived records from the device.

 
Figure 4.8—System and Archives status

SYSTEM STATUS
System Status provides a brief synopsis of device health. Note the power source indicated as the Active Pow-
er Source and verify it is correct. This is especially important if the device is to be externally powered and this 
display indicates that the active power source is Battery.
When a lithium battery is installed, the MC Synergy  starts the automatic coulomb counter and begins tracking 
battery health. A low alarm will trigger when the battery life is less than 20% for at least 10 seconds. A low-low 
alarm will trigger when battery life is depleted to 10%, alerting you to replace the batteries. Total power loss 
to the device may cause the totals to be lost (except from the most recently archived record). Refer to the MC 
Synergy Hardware User Manual for detailed battery replacement instructions.
You may also use the System Status display to verify that the digital voltage is not grounded (i.e. it reads ap-
prox. 2.5 V).
When an option board is present, the MC Synergy provides a measurement of internal power supply called 
Expansion Voltage. When the Ethernet option board is installed and customer power is applied to the Ether-
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net board, the system will measure approximately 5.1 VDC. When the HART/Analog output board is installed 
and the customer loop-power is applied, the system will measure 9 to 14 VDC. 

ARCHIVES STATUS
Archives Status shows the number of daily, interval, event, and alarm records stored in the device so you can 
assess remaining capacity before data becomes overwritten. Up to 384 daily records, 768 interval records, 
768 event records, and 768 alarm records can be archived before the oldest data is overwritten.

NETWORK STATUS
The Network Status (Figure 4.9) shows information pertaining to the Ethernet expansion board (if installed). 
This information will help you detect, connect to, and communicate with the device remotely, while retaining 
the use of the serial ports for other applications. The Ethernet port may be used to communicate with the de-
vice via Modbus-TCP or Modbus Over TCP. There are no advantages of one protocol over the other, and so 
determining which protocol to use will usually be dictated by the application. Most slave devices (or “servers” 
in Modbus-TCP) only support one protocol or the other.

Figure 4.9—Network status

Modbus-TCP is a simple, vendor-neutral communication protocol intended for supervision and control of au-
tomation equipment. Specifically, it covers the use of Modbus messaging in an ‘Intranet’ or ‘Internet’ environ-
ment using the TCP/IP protocols. Some common uses are Ethernet attachment of PLC’s, I/O modules, and 
‘gateways’ to other simple field buses or I/O networks.
Modbus Over TCP is typically used by serial servers supporting Modbus Ethernet client communications with 
multiple Modbus RTU-RS485 slaves. The serial server strips off the Ethernet section, and forwards the Mod-
bus RTU message on to the serial port(s).
For additional information refer to Ethernet Port, page 48.

Note Network settings will be populated on the Device Status screen even when power is not being 
applied to the Ethernet board. Don't confuse this with validation of a network connection. For tips 
on validating a network connection, see Verification of Ethernet Connection, page 32 below.
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VERIFICATION OF ETHERNET CONNECTION
To verify the Ethernet board is operating as expected, enter the IP Address of the board into a browser ad-
dress bar. A web page will verify the Ethernet connection (Figure 4.10). 
To identify the IP address, look for the IPv4 address in the software Network Status display. Alternatively, you 
can tap the INC button on the MC Synergy keypad. The display will cycle through settings including the IP ad-
dress of the Ethernet board. 
A valid Ethernet connection will generate the web page verification shown below.

Figure 4.10—Ethernet connection verification
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Section 5: Configuration Basics
Before you make changes to your device's configurable settings, it is important to understand how configura-
tion files are created, edited, uploaded, and saved. That is the purpose of this section.
Sections 6, 7 and 8 will expand on this information, providing step-by-step instructions for configuring system, 
turbine and outputs settings.
There are two ways to configure an MC Synergy device via the PC software:
1. Upload configuration settings to a connected device.
2. Build a configuration file offline when your computer is disconnected from a device.
Procedures for both configuration methods are provided below.

CONFIGURATION FILE MANAGEMENT
MC Synergy configuration is essentially a two-step process involving editing settings in the software interface 
and uploading the changes to a device (or saving them to a file for uploading at a later date).
Configuration settings are stored in the MC Synergy and downloaded each time you connect to an MC Syner-
gy via PC software. However, these settings can also be saved to a file using a proprietary .srf format (Figure 
5.1). SRF files can be saved to a computer and imported into one or multiple field devices as needed.

Figure 5.1—SRF configuration file format

The PC software interface gives you multiple ways of creating, changing, saving, and deploying configuration 
settings. Click the Configure Device tile from the navigation menu to observe four configuration functions ac-
cessible from this menu (identified by gray buttons with icons below the navigation menu):

• Upload to Device - saves new selections and changed selections to the connected MC Synergy device
• Re-Read From Device - discards unsaved configuration selections and restores configuration to the 

settings last saved to the connected MC Synergy device
• Import from SRF File - imports user-selected configuration settings from another configuration file and 

highlights affected setting groups to prompt you to verify these changes 
• Save to SRF File  - saves a copy of the current configuration selections to a configuration file that can be 

stored on a computer and used to reconfigure other devices
• View Change Report - provides a preview of unsaved changes

If you have a need to upload a configuration to many units, you should also consider the wizard-based Upload 
From SRF File operation in the Manage Device menu. It is similar to the Import from SRF File operation, but 
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allows you to make all changes from a condensed set of dialogs and execute the upload without returning to 
the configuration menu. See Configuration Upload, page 86 for details.

CONFIGURING A CONNECTED DEVICE
Before attempting to configure your device using this method, review the instructions in Section 2: Connecting 
to a Device, page 11 to ensure you are properly connected to your MC Synergy.

SAVING AND UPLOADING CHANGES TO A DEVICE
To configure a connected device, proceed with these steps:
1. Select the Configure Device tile from the navigation menu (Figure 5.2). 

Figure 5.2—Configure Device menu tile

2. Select an item from the grid of System, Turbine, and Outputs submenus.
3. Update the configurable fields as necessary using the guidelines provided in sections 6, 7, and 8.
4. Click OK to save the changes entered on each configuration screen.
5. Repeat steps 2 through 4 for all submenu settings that are applicable to your installation.
6. When your configuration selections are complete and saved, return to the main Configure Device screen 

and click Upload to Device (Figure 5.3, page 35) to save and apply the changes to the connected 
device. 



35

NUFLO MC Synergy Software  Section 5

Figure 5.3—Buttons for uploading a configuration to a device or saving a configuration file to your computer 

SAVING A CONFIGURATION FILE (SRF)
To store the configuration in an SRF file on your local computer to be uploaded to a device at a later time, 
click Save to SRF File (Figure 5.3). 
By default, your SRF file will be saved to your hard drive: C:\Sensia Data\NuFlo MC Synergy Interface. The 
default filename comprises the prefix MCS, the serial number of your device, and a date and time stamp (for 
example, MCS_sn1234567_20230516_181055.srf).
However, both the file path and the filename are user-configurable. If you use offline configuration frequently, 
you can save steps by changing the default file path. This is easily achieved through the Tools menu. See 
Section 11: Interface Options, page 93 for instructions.

CONFIGURING A DEVICE OFFLINE
This configuration method allows you to build a configuration without a device connection by creating a new 
SRF file or editing the settings in an existing SRF file. You can edit the settings, and save the new configura-
tion as a local file on the computer. See sections 6 through 8 for information on individual configuration set-
tings.
To ensure compatibility of the configuration file and the device it will be loaded into, verify that any existing file 
that you are using as the basis for configuration edits was created for the firmware version installed on your 
MC Synergy device. If you cannot confirm a match, you should create a new configuration file targeted to the 
desired device platform (firmware version).
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To create or edit a configuration file offline, proceed with these steps:
1. Press the Edit Configuration File button on the Home page (Figure 5.4).
2. From the Edit a Configuration File screen (Figure 5.5, page 37), select a file access method: open a 

recent file, choose an existing file from the computer, or create a new file.

Figure 5.4—Home page 
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Figure 5.5—Edit a Configuration File screen

3. To create a new configuration file, choose a target device platform from the Edit a Configuration File 
screen (Figure 5.6) that corresponds with the firmware loaded onto the device that is being configured. 
At the time of product release, the MC Synergy Totalizer | Register Table 6 was the only target device 
platform available. If you are presented with other register table versions, contact the factory to confirm 
compatible firmware versions.

Figure 5.6—Target Device Platform selection for new configuration files  

4. From the Offline Configuration Menu (Figure 5.7, page 38), select an item from the grid of System, 
Turbine, and Outputs submenus. 
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Figure 5.7—Offline Configuration menu

5. Update the configurable fields as necessary using the guidelines provided in sections 6, 7, and 8.
6. Click OK to save the changes entered on each configuration screen.
7. Repeat steps 4 through 6 for all submenu settings that are applicable to your installation.
8. When your configuration selections are complete and saved, return to the main Offline Configuration 

Menu screen and click one of the Save SRF File buttons in the top left corner of the screen (Figure 5.7).

 – Save SRF File. Saves the current configuration to the opened SRF file.
 – Save SRF File As. Opens a window and prompts the user to select a file name and location for the 

SRF file.

9. Click the Close File button in the top right corner of the Offline Configuration Menu screen to close the 
SRF file. 

 – If unsaved changes are detected, you will be prompted to save them. 
 – If you opt to not save them, the changes will be deleted and the SRF file will close, preserving its 

unedited content.

CHANGING DEFAULT FILE ACCESS
If you create or edit configuration files offline regularly, you may wish to change the default file access setting 
in the software. Simply choose Tools>Options from the menu bar at the top of the screen, and select a new 
default file access method from the General option group screen. See General Settings, page 94 for more 
information. Changes will take effect with the next connection to the device.
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CHANGE REPORT
Before saving changes to an SRF file or uploading changes to a connected device, you can inspect your 
changes by clicking the View Change Report button located to the right of the navigation menu tiles (Figure 
5.8). 

Figure 5.8—Report for inspecting changes before saving to SRF or uploading them to a connected device

The Change Report (Figure 5.9, page 40) contains two columns for comparing values from the last suc-
cessful save/upload (Original File Value) and the unsaved changes you just made (Changed Value). Changed 
settings are highlighted in red for easier viewing. 
Click the Show Changed Fields Only link to filter the view to unsaved changes. This view exists only when 
there are UNSAVED changes. Once the new changes are uploaded or saved to an SRF file, the content of 
the two columns will be identical and no red highlights will remain.
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Figure 5.9—Configuration Change Report

UNSAVED CHANGES ALERT
If you have entered configuration changes but have not uploaded them to the device, a red Unsaved Changes 
alert will appear in the upper right corner of  the Configuration Menu screen (Figure 5.10, page 41). To view 
the changes, click View Change Report.
By contrast, when there are no unsaved changes, the alert space will display "No Unsaved Changes" in green 
text.
If unsaved changes exist when you attempt to exit the Configure Device menu, an Alert dialog will appear to 
prompt a save or discard decision. 
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Figure 5.10—Unsaved Changes alert

CONFIGURABLE SETTING SUMMARY
See the following tables for a summary of configurable parameters described in Sections 6 through 8.

TABLE 5.1—SYSTEM PARAMETERS (SECTION 6)

Device Units (page 43)
Choose measurement units for each MC Synergy parameter. Configure all the units 
to either US customary units or SI metric units or configure units for each parameter 
individually.

Device Identification (page 
46)

Store information about the MC Synergy. This information differentiates your connected 
MC Synergy device from other networked devices.

Serial Ports (page 47) Choose serial port settings for Modbus communication with other devices.
Ethernet Port (page 48) Available only with the installation of an Ethernet expansion board. Choose Ethernet 

settings to connect the MC Synergy to a LAN network. The MC Synergy supports 
Ethernet communication via Modbus-TCP and Modbus over TCP.

Device Interface (page 
51)

Choose LCD settings, reset input settings, keypad lock and display settings for the 
device.

Bluetooth Setup (page 
54)

Built-in Bluetooth communications on the device may be used to configure and 
communicate with the device using a free Bluetooth mobile application installed on your 
smart phone or tablet. Depending on the operations to be performed via Bluetooth, 
the Bluetooth session period may need to be lengthened (to remain paired through an 
anticipated idle period) or shortened (to reduce the power draw).

Archives Setup (page 
56)

Change the contract hour and the interval at which the connected MC Synergy will record 
and log selected data.

Alarms Setup (page 58) Create up to eight user-configurable alarms for a connected MC Synergy.

TABLE 5.2—TURBINE PARAMETERS (SECTION 7)
Turbine Input (page 61) Enter the turbine meter’s input parameters, which can be done through the Turbine Input 

screen.
K-Factor Entry (page 64) Enter information supplied with a NUFLO turbine meter to monitor its health and calibrate 

the MC Synergy with the appropriate K-factor(s) and, if applicable, meter factor(s).
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TABLE 5.3—OUTPUT PARAMETERS (SECTION 8)
Analog / HART (page 69)  Available only with the installation of an analog/HART expansion board. Configure a 

traditional 4 to 20 mA analog output or configure HART communication between HART 
compliant devices through bi-directional communication. The HART Interface can be 
configured in either of two modes: Multidrop, or 4 to 20 mA Loop (also referred to as 
Point-To-Point).

Digital Outputs (page 74) Configure either or both of two MC Synergy digital outputs. Outputs can be configured 
to trigger on alarm status, turbine input, flow volume, Specified Precision Pulse Output, 
Scaled Pulse Output, Status Output, Amplified Raw Output, or to remotely activate an 
output from the MC Synergy via Modbus. By default, digital outputs are disabled.
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Section 6: Configure System Settings
This section provides step-by-step instructions for configuring system parameters (Figure 6.1).
If you are new to the MC Synergy interface, review Section 5: Configuration Basics, page 33 for an over-
view of configuration menus and methods. See also Section 7: Configure Turbine Settings, page 61 and 
Section 8: Configure Outputs Settings, page 69.
System configuration includes defining device units for calculation, system information, remote communica-
tion, local display, alarming, and data storage and retrieval.

Figure 6.1—System configuration menus

DEVICE UNITS
The Device Units screen (Figure 6.2, page 44) supports configuration of measurement units for each MC 
Synergy parameter. 
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Figure 6.2—Device Units screen

1. Select a Default Units system, which is typically the unit system used by the country or region where the 
device will be installed. This selection will be used to display values that do not have user-configurable 
units.

 – US Customary Units applies to countries including U.S., Liberia, and Myanmar.
 – SI (System of International) Metric Units applies to most other countries.

2. Configure individual measurement units from the Measurement Units List as described in Table 6.1—
Measurement Units, page 45. These units will override the settings applied by the Default Units System 
selection.

3. Click OK in the top right corner of the screen to save changes.
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TABLE 6.1—MEASUREMENT UNITS
Total Volume Display

• Units Selection. Sets the units of the totals measured. Set 
for m3, ft3, l, gal, or bbl.

• Scale Units By 1000. If selected, a “x1000” will be added, 
and the decimal place of the most significant digit will be 
reduced by 3 places.

• Decimal Place Rounding. Sets the measurement precision 
for total.

Flow Rate Display

• Units Selection. Sets the units of the volume flowing 
through the pipe. Set for m3, ft3, l, gal, or bbl.

• Time Base. Sets the time over which the selected volume 
will be measured. Set for sec, min, hr, or day.

• Scale Units By 1000. If selected, a “x1000” will be added, 
and the decimal place of the most significant digit will be 
reduced by 3 places.

• Decimal Place Rounding. Sets the measurement precision 
for the flow rate.

Meter Flow Range

• Units Selection. Sets the units of the volume flowing 
through the meter. Set for m3, ft3, l, gal, or bbl.

• Time Base. Sets the time over which the volume will be 
measured. Set for sec, min, hr, or day. 

• Decimal Place Rounding. Sets the measurement precision 
for the turbine meter flow range.

K-Factor

• Units Selection. The volume is incremented from turbine 
meter calibration per pulse registered. No other units are 
selectable.

• Units Denominator Selection. Sets the units of the volume 
flowing through the meter. Set for m3, ft3, l, gal, or bbl.

• Decimal Place Rounding. Sets the measurement precision 
for the turbine meter K-factor.
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DEVICE IDENTIFICATION
The Device Identification screen (Figure 6.3) allows you to store information about the MC Synergy to differ-
entiate it from other networked devices. 
1. Enter settings as desired for the information you wish you use to identify your meter. 
2. Click OK in the top right corner of the screen to save the changes.

Figure 6.3—Device Identification screen

Configurable settings include:

• Company Name. Maximum 20 characters. This is the name of the company managing the site/well.
• Site/Well Name. Maximum 20 characters. This is the site name/number or well name/number where the 

MC Synergy is installed.
• Field/Lease Name. Maximum 20 characters. This is the field or lease name/number in which the site/well 

resides.
• Location Name. Maximum 20 characters. This is a description of the MC Synergy's location. It can be a 

name, GPS coordinates (DMM or DD), etc.
• Device/Meter Name. Maximum 10 characters. This is a unique identifier for the MC Synergy that 

differentiates it from other network devices.
• Legal Description. Maximum 34 characters. This is the legal land description.
• User Note. Maximum 64 characters. This can be used for any additional information regarding the MC 

Synergy installation.
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SERIAL PORTS
The Serial Ports screen (Figure 6.4) allows you to configure each serial port’s settings for communication with 
other devices via Modbus. 
1. Enter settings as desired for serial port communication, using the bulleted references below as needed.
2. Click OK in the top right corner of the screen to save the changes.

Note When a connection is established with an MC Synergy, the software detects the port that is 
connected and displays the connection status in the framed navigation window at the top of the 
screen.

Figure 6.4—Serial Ports screen

PORT SETTINGS
Configurable settings include:

• Slave Address. Default is 1. The slave address allows the MC Synergy to communicate with other devices 
via Modbus.

Note Standard Modbus queries require the slave addresses to be between 1-255. The MC Synergy 
also supports extended addressing for addresses between 255-65535.
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• Baud Rate. Default is 9600. The baud rate is the speed at which data is transmitted or received via the 
serial port. Available baud rate selections include: 300, 1.2k, 2.4k, 4.8k, 9.6k (low power), 9.6k, 19.2k, 
34.8k, and 57.6k. The low power mode is for compatibility with the Sensia MC-III totalizer only. For the 
MC Synergy, all baud rates are low energy, and so any baud rate selected will operate in low energy 
mode.

• Bus Delay. Default is 10 msec (must be set in 10-msec increments). The bus delay is the amount of time 
(in milliseconds) that passes before the MC Synergy attempts to take control of the RS-485 bus and 
transmit a message back to the requesting device. This delay may be lengthened if the MC Synergy is 
connected to a slow acting flow control, which requires time for the client device to switch back to receive 
mode after transmitting.

• Bus Timeout. Default is 50 msec (must be set in 10-msec increments). The bus time is the number of 
milliseconds that must pass to cause the MC Synergy to reset its internal Modbus message handler. You 
may lengthen the timeout for a client device that has gaps or pauses in transmission.

PORT ACCESS RESTRICTIONS
The Serial Port Access Restrictions may be used to restrict interactions with the MC Synergy device over 
Modbus through the serial port. Enter the following to set up the desired Modbus restrictions:

• Enable Access Restrictions. Use this setting to specify restricted or unrestricted access through serial 
port to the MC Synergy registers. If Serial Port 1 is the master port, you may choose to allow unrestricted 
access.

• Read Access Mode. The access mode may be changed to Read only if access will be given to obtain 
values from registers, and it is necessary to protect settings or readings from being overwritten via the 
specified serial port.

• Lowest Allowed Register. Use this setting to prevent access to registers below a specified address.
• Highest Allowed Register. Use this setting to prevent access to registers above a specified address.

Enron Access Restrictions
Enron archive records are historical daily, interval, event, and alarm records that are logged based on the Ar-
chives Setup, page 56. 
By default, access to these records is unrestricted.
To restrict access, change the setting for Restrict Enron Archive Retrieval to "No." This may be a consider-
ation if the port will not be used explicitly for MC Synergy communications.

ETHERNET PORT
The Ethernet Port screen (Figure 6.5, page 49) allows you to configure Ethernet settings to connect the MC 
Synergy to an LAN network. The MC Synergy supports Ethernet communication via Modbus-TCP and Mod-
bus over TCP. 
1. Enter settings as desired to configure Ethernet communications. 
2. Click OK in the top right corner of the screen to save the changes. To verify the Ethernet connection, see 

Verification of Ethernet Connection, page 32.
The Ethernet port may be used to communicate with the device via Modbus-TCP or Modbus Over TCP. There 
are no advantages of one protocol over the other, and so determining which protocol to use is usually deter-
mined by the application. Most slave devices (or “servers” in Modbus-TCP) support only one of these proto-
cols.
Modbus-TCP is a simple, vendor-neutral communication protocol intended for supervision and control of 
automation equipment. Specifically, it covers the use of Modbus messaging in an ‘Intranet’ or ‘Internet’ envi-
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ronment using the TCP/IP protocols. Some common uses of the protocols at this time are for Ethernet attach-
ment of PLC’s, I/O modules, and ‘gateways’ to other simple field buses or I/O networks.
Modbus Over TCP is typically used by serial servers where a Modbus Ethernet client communicates with 
multiple Modbus RTU-RS485 slaves via a serial server. The serial server strips off the Ethernet section and 
forwards the Modbus RTU message on to the serial port(s).

Figure 6.5—Ethernet Port screen

NETWORK CONFIGURATION

Ethernet Settings
The Ethernet settings should be supplied by the network administrator to ensure proper connection and pre-
vent collision between devices on the network. The settings will depend upon the configuration of the network 
and the maximum transmission unit (MTU) for the connected devices. When an Ethernet expansion board is 
connected to the MC Synergy, these settings may automatically populate.

• Enable MTU Fragmentation. Breaks the Ethernet packets into the desired “fragments” to match the MTU 
size.

• Maximum Transmission Unit (MTU). The maximum receivable packet size over the Ethernet connection.
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• Enable Ethernet VLAN. Activates a virtual LAN connection to communicate with other devices virtually, 
but not necessarily physically connected devices.

• Ethernet VLAN Identifier. This setting may be any value between 1 and 4093 to uniquely identify the device 
on the VLAN.

Static IP Settings
Static IP settings should be supplied by the network administrator to ensure proper connection and to prevent 
collision between devices on the network. If static IP configuration is disabled, the device will have a dynamic 
IP configuration.

MODBUS-TCP PORT 

Port Settings
The MC Synergy supports Modbus TCP protocol by transmitting a Modbus TCP message inside a TCP pack-
et. This protocol should not be confused with Modbus Over TCP. If you are unsure if your device will be using 
Modbus-TCP or Modbus Over TCP, contact your network administrator.

Note The TCP Port Number is fixed to 502, and the Unit ID is fixed to 1. These settings are not edit-
able. 
Modbus-TCP may have up to 16 active queries. If the number of active queries exceeds 16, the 
MC Synergy will respond with a “Device Busy” (0x06) message.

Port Access Restrictions
Modbus-TCP Port Access Restrictions may be used to restrict interaction with the MC Synergy device over 
Modbus through the serial port. Enter the following to set up the desired Modbus restrictions:

• Enable Access Restrictions. Use this setting to specify restricted or unrestricted access to the MC 
Synergy registers.

• Read Access Mode. Change the access mode to Read only if access will be given to obtain values from 
registers, and it is necessary to protect settings or readings from being overwritten.

• Lowest Allowed Register. Use this setting to prevent access to registers below a specified address.
• Highest Allowed Register. Use this setting to prevent access to registers above a specified address.

MODBUS OVER TCP PORT 

Port Settings
The MC Synergy supports Modbus Over TCP protocol by transmitting a Modbus RTU message inside a TCP 
packet. This protocol should not be confused with Modbus TCP. Modbus Over TCP supports the Enron exten-
sion of Modbus. If you are unsure if this device will be using Modbus-TCP or Modbus Over TCP, contact your 
network administrator.

Note The TCP Port Number is fixed to 503, and the Slave Address is fixed to 1. These settings are not 
editable. 
Modbus over TCP may have only 1 active query. If there are multiple active queries, the MC 
Synergy will respond with a “Device Busy” (0x06) message.
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Port Access Restrictions
The Modbus over TCP Port Access Restrictions may be used to restrict interaction with the MC Synergy de-
vice over Modbus through the serial port. Enter the following to set up the desired Modbus restrictions:

• Enable Access Restrictions. Use this setting to specify restricted or unrestricted access to the MC 
Synergy registers.

• Read Access Mode. Change the access mode to Read only if access will be given to obtain values from 
registers, and it is necessary to protect settings or readings from being overwritten.

• Lowest Allowed Register. Use this setting to prevent access to registers below a specified address.
• Highest Allowed Register. Use this setting to prevent access to registers above a specified address.

Enron Archive Records
Enron Archive records are the historical daily, interval, event, and alarm records logged based on the archive 
settings configured for a connected device (see Archives Setup, page 56). 
By default, access to these records is unrestricted.
To restrict access, change the setting for Restrict Enron Archive Retrieval to "No." This may be a consider-
ation if the port will not be used explicitly for MC Synergy communications.

DEVICE INTERFACE
The Device Interface screen (Figure 6.6, page 52) allows you to configure LCD display, keypad, and reset 
input settings and choose the items to be displayed in real time. 
1. Enter device interface settings as desired.
2. Click OK in the top right corner of the screen to save the changes.
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Figure 6.6—Device Interface screen

DEVICE INTERFACE SETUP 

LCD Display Settings
You can configure the following LCD display settings from the PC software: 

• Display Cycle Period. Specifies the update frequency of the LCD. The display will refresh (if in Display 
Total and Rate mode) or go to the next display item (if in Display Item Selections mode). You can enter 
a cycle time between 1 and 300 seconds. This is not related to the period over which the device will 
calculate totals and flow rate.

• LCD Contrast Setting. You can adjust the contrast on the LCD from 0 to 31 to optimize the display 
readability.

• Suppress User, System, or Turbine Alarms Display. By default, the device will flash active alarms on the 
display while they are active. You can hide the alarms status of one or more alarms to keep the display 
static. This is particularly useful if the alarms are being monitored remotely, or are set to trigger a local or 
remote alarm response when activated. Thus, the display is only required to indicate the total, rate, and 
non-alarm status alerts. Suppressing these alarm displays will not affect the alarm output.

• Suppress Automatic Rate Decimal. The rate decimal may be fixed, such that screens being recorded may 
be done so without attention needing to be paid to the place of the decimal on the rate.
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Keypad Settings
You can enable a keypad lock with a four-digit lock code to restrict access to the device via the local user 
interface. When the keypad lock is enabled, you will be prompted to enter the lock code when you attempt to 
enter a configuration menu. 
You can also reduce keypad sensitivity or turn off keypad sensing to improve battery life or if the local user 
interface is not required.

Reset Input Settings
The reset input settings apply only to EXP models with an optional reset switch installed. A short press of the 
switch will advance the display item, and a long press can be configured to perform any of four additional 
tasks. These configurable functions include clear grand flow totals, clear unacknowledged alarms (and reset 
latched digital outputs), create an archive partial record, or publish polling accumulators (commonly used in 
batch applications). See Device Commands, page 89, for more information. 
The MC Synergy using polling accumulators to store the volume accumulated since the last polling sequence 
in the Polling Total. When you initiate a new polling sequence, the current polling total is transferred to the 
previous polling total, while resetting the current polling total to zero. For more information, see "Polling Regis-
ters" in Appendix C—Modbus Protocol in the MC Synergy hardware manuals.

Note If the reset input switch is configured to acknowledge active alarms, and the device is in an 
alarm condition when the switch is pressed, the alarms will not be acknowledged, and the alarm 
will remain active. 
If a reset input switch is configured to clear unacknowledged alarms, a press of the switch will 
also clear any latched Digital Output status signals associated with an alarm.

DISPLAY ITEMS
By default, the LCD is configured to display total and rate, but you can edit the configuration to display up to 
eight user-selected items.

Display Total and Rate
This factory default setting will display the grand total, flow rate, and status alerts (Figure 6.7). Active alarms 
will also display, if they are not suppressed.

Figure 6.7—Display Items (default)
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Display Item Selections
You may configure up to eight custom display items to cycle through the display during operation. By default, 
instantaneous flow rate, daily total, and previous day total are displayed (Figure 6.8). Click Edit Display Item 
to add or edit an item.

 
Figure 6.8—Display Items (custom user selections)

Here are the settings you can specify for a display item:

• Enabled. Select YES to display the item. Select NO to prevent the item from displaying. 
• Register Selection. Select the item you wish to display from a list of registers.
• Selection Units. The unit that is preconfigured for your selection will appear in uneditable form. To change 

the units for totals and flow rate, see Device Units, page 43.
• Display Label. Enter a custom display label. It is recommended that this be configured to match the 

nomenclature defined for the site.
• Decimal Position. Select the precision level that you want used for the display of your selected item. This 

entry will not affect measurement precision for totals and flow rates. See Device Units, page 43, for 
more information on measurement precision.

BLUETOOTH SETUP 
If you wish to check meter status or configure MC Synergy settings from your smart phone or tablet using the 
Sensia Digital Data Plate app, you can enable Bluetooth communications within the MC Synergy with these 
settings (Figure 6.9, page 55). 
1. Select YES in the Enable Bluetooth dropdown menu.
2. Adjust the session period if desired. This is the length of time a connection will be retained once your 

mobile device is successfully paired with the MC Synergy device.
3. If you wish to password protect your equipment from unauthorized use, enter a user-specified pair code. 

This setting is optional.  
4. Click OK in the top right corner of the screen to save the changes.
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Figure 6.9—Bluetooth Setup screen

Depending on the operations you will perform via Bluetooth, the 5-minute default session period may need 
to be lengthened or shortened. For example, a longer session may be required to stay connected through an 
anticipated idle period, or a shorter period may be desired to reduce the power draw. 
A pair code is an optional passcode setting that can help reduce the risk of unauthorized access to the de-
vice.  When enabled, you will be prompted to enter it when attempting a Bluetooth connection with the device. 
Choose a pair code that is 6 digits or fewer. Use only numbers; letters and symbols are not supported. To dis-
able the pair code, enter the default code 000000. 
For instructions on making a Bluetooth connection with the device and navigating the app, see the MC Syn-
ergy hardware manuals and quick-start guide.

Note To minimize the risk for communication interference, terminate your PC connection to an MC 
Synergy  device before connecting to the same device with the mobile app.
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ARCHIVES SETUP
The Archives Setup screen (Figure 6.10) allows you to control which parameters are logged by the MC Syn-
ergy, and the frequency of those logs. The MC Synergy will hold up to 384 daily records, 768 interval records 
(configured from 1 minutes to 12 hours), 768 event records, and 768 alarm records. Once the archive items 
list is full, the oldest records will be overwritten by the newest records. 

CAUTION
Before changing the selected parameters in the Archive Item list, download the archives to 
prevent an inadvertent loss of data. ScanData, the PC software used to view archive data, will 
validate and present records that match the currently configured list of parameters. ScanData 
will not show archive records from previously configured items.

1. Enter archive settings as desired.
2. Click OK in the top right corner of the screen to save the changes.

Figure 6.10—Archives Setup screen
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GENERAL SETUP
At the top of the screen, select the contract hour and the interval at which the connected MC Synergy will re-
cord and log selected data. 

• Contract Hour. This is the time of day all records from the previous 24 hours are gathered and stored. 
Ensure the time on the device has been synchronized/set so that the selected contract time is correct.

• Interval Period. By default, interval logs are recorded hourly. Click Edit to change the interval period. You 
may configure this setting in hours, minutes, or seconds. For example, you can enter "10" and "minutes" 
to log flow data every 10 minutes (Figure 6.11).

Figure 6.11—Edit Time Interval dialog

ARCHIVE ITEMS
Date, time, and device status is captured with every log entry.
You may edit archive items 1 through 7 from a list of pre-defined registers to be stored at the user-specified 
intervals, and published at the user-specified contract hour. The Edit Archive Item dialog (Figure 6.12) shows 
the units in which the selected archive item will be stored. Units are not editable from the Archive Setup menu. 
The K-factor, meter factor, totals, and flow rate units may be configured in the Device Units menu. 
You can reset a selected archive item to its default configuration. Or, to reset all archive items to their default 
configurations, click Reset All Archive Items in the Archives Setup screen.

Figure 6.12—Archive register selection
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ARCHIVE SIZES
The MC Synergy will hold up to 384 daily records, 768 interval records (configured from 1 minutes to 12 
hours), 768 event records, and 768 alarm records, as shown in (Figure 6.10, page 56). The Total column 
shows the archive capacity, and the Stored column shows the number of records stored. 
Once the number of stored archive records reaches full capacity, the oldest records will be overwritten by the 
newest records. 
To preserve archived records, download the archive before it reaches full capacity. Interval records have the 
highest likelihood of being overwritten due to the frequency of their creation. For example, if the interval pe-
riod is 1 hour (default), the interval archive will reach full capacity in 32 days. 

Note Downloading the archive records will not reset the Stored value. When the Stored archive reach-
es capacity, the oldest records will begin to be overwritten by the newest archive records, but the 
total number of archives in storage will remain the same.

See Section 9: Download Archives, page 81, for more information.

ALARMS SETUP
The Alarms Setup screen (Figure 6.13, page 59) allows you to configure up to eight user alarms per con-
nected device. 
1. Enter alarm settings as desired.
2. Click OK in the top right corner of the screen to save the changes.

To see the status and history of alarms, see Alarms Status, page 25. 
When an alarm is active, it will be recorded in the alarm log and transmitted as an Enron event. If the alarm 
condition is configured as a status output, a digital output will be activated. (See Status Output, page 77 to 
configure a digital output).
In addition to configuring alarms, you can reset a selected alarm item (clearing alarm configuration for that 
item), or reset all alarm items to their default configurations (no alarms configured) using the Reset buttons 
provided.
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Figure 6.13—Alarm Setup screen

To configure an alarm, click an unused row in the Alarm Items List and click Edit Alarm Item (Figure 6.14). 

Figure 6.14—Edit Alarm Item dialog

Here are the settings you can specify for an alarm item:

• Enabled. While you will typically choose Yes to enable a new alarm configuration, you may also use this 
setting to temporarily disable an alarm to verify wiring upon installation, to test the alarm, or to debug an 
alarm.

• Register Selection. Select the item you wish to alarm on from a list of registers. An alarm can be assigned 
to only one register at a time.
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• Selection Units. The unit that is preconfigured for your selection will appear in uneditable form. To change 
the units for K-factor, meter factor, totals, and flow rate, see Device Units, page 43. 

• Alarm Label. This is a unique identifier of the turbine meter, flow line, etc. being monitored for an alarm 
condition. This label may be transmitted via a serial or Ethernet connection for a monitoring system to 
identify the alarm condition and notify you.

• Alarm Type. This setting defines the type of setpoint associated with the alarm condition. Alarms can be 
configured to trigger based on a high setpoint, a low setpoint, or on both high and low setpoints. You may 
establish a two-level alarm by assigning a high/low alarm and a high-high/low-low alarm to the same 
register. Each alarm can only be assigned to one register at a time. Therefore, if a two-level alarm is 
desired, two alarms must be entered for the same register—one to assign a high/low alarm, and one to 
assign a high-high/low-low alarm.
 – High Setpoint. The alarm will activate when the value of the configured item exceeds the user-

specified setpoint.
 – Low Setpoint. The alarm will activate when the value of the configured item drops below the user-

specified setpoint.

Note A High-High, Low-Low, or windowed High-High/Low-Low alarm is configured to alert the user via 
Enron, as well as via software, local user interface, alarm logs (and digital output, if configured to 
output status). See Status Output, page 77 for more information).

• Deadband. This setting is the value by which the item in alarm must drop below the alarm point to 
deactivate. This helps prevent alarm chatter while an alarm value hovers around the alarm condition and 
ensures that the alarm does not deactivate until the value is within a safe range from the trigger point.

• Hold-Off Period. This setting will delay an alarm activation by the specified number of seconds entered. If 
a value temporarily enters an alarm condition, this hold-off period allows time for the value to move back 
into a non-alarm condition rather than instantaneously triggering an alarm.
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Section 7: Configure Turbine Settings
To configure turbine settings for an MC Synergy, select the Configure Device tile from the navigation menu 
and locate the Turbine settings in the submenu grid (Figure 7.1). 
If you are new to the MC Synergy interface, review Section 5: Configuration Basics, page 33 for an over-
view of configuration menus and methods. See also Section 6: Configure System Settings, page 43 and 
Section 8: Configure Outputs Settings, page 69.

Figure 7.1—Turbine configuration menus

Turbine settings are presented as two menus in the MC Synergy software. The Turbine Input menu contains 
the settings for defining the input signal from the turbine meter that will be brought into the device. The K-
Factor Entry menu contains calibration information for the connected turbine meter.

TURBINE INPUT
Configuring a turbine meter begins with configuring the turbine meter’s input parameters, which can be done 
through the Turbine Input screen (Figure 7.2, page 62).
1. Enter turbine input settings as desired.
2. Click OK in the top right corner of the screen to save the changes.
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Figure 7.2—Turbine Input screen

TURBINE INPUT SETTINGS

• Sampling Period. This is the length of time (in seconds) that MC Synergy samples the pulses from the 
turbine before updating the data.

• Rate Damping Factor (Future) 
• Pulse Input Type. The type of input coming in which will be specified on the turbine meter connected to 

the MC Synergy (Figure 7.3, page 63).
 – Digital Pulse Input. The turbine meter will send a square wave to the turbine input. For this input it is 

necessary that the signal is energized. If the MC Synergy is not receiving a signal, check the input 
voltage. Refer to the MC Synergy Hardware User Manual for wiring instructions. 
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Figure 7.3—Change Turbine Input dialog

 – Turbine Magnetic Pickup. Select this input type when the MC Synergy is connected to a magnetic 
pickup from a turbine meter. In this configuration, the MC Synergy is expecting a low-level sine-wave 
signal  whose frequency and amplitude is proportional to the rotational velocity of the turbine meter's 
rotor. 

 – Closed Contact Input. A normally closed contact, usually via a reed switch, provides an input with 
internal pull-up resistor to approximately 3 VDC. 

• Input Threshold. Only for Turbine Magnetic Pickup input type. The minimum acceptable voltage required 
for pulses to register. The threshold selected will depend upon the potential signal noise that may be 
present during operation (i.e. vibration may cause one strong signal to be accompanied by smaller 
signals).

• Low Input Freq. Cutoff. The MC Synergy will ignore pulses if the pulse frequency drops below this cutoff 
value.

• Low Flow Rate Cutoff. The MC Synergy will cease accumulation of flow time in the hourly and daily records 
if the turbine flow rate drops below this cutoff value.

TURBINE HEALTH TEST

• Health Test Sensitivity Level. Permits the user to select a pre-configured turbine health testing setup, or to 
make a custom configuration, based upon the needs of the installation. These three parameters help the 
user to identify the validity of an error, and to ensure that small mechanical or electrical anomalies do not 
cause an error to unduly trigger a turbine alarm.

• Health Test Period. Represents the time over which the health of the meter will be analyzed. If signals are 
present that represent an error in the meter, then the appropriate turbine alarm will be activated. These 
may include, a bent blade, missing blade, erratic signal, replace kit, or an error with a blade angle.
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• Event Count Threshold. The value will determine how many times an error event may be detected before 
it is considered to be valid, and will trigger an alarm.

• Event Accumulation Interval. This sets a boundary on the length of time the device will count the error 
events before resetting the error event count.

TURBINE INPUT UNITS
The bottom section of the Turbine Input  screen displays the volume and flow rate units that are currently con-
figured on the device. Go to Device Setup to edit these units. See Device Units, page 43 for more informa-
tion.

K-FACTOR ENTRY
The K-Factor Entry screen (Figure 7.4, page 65) allows you to enter information supplied with the turbine 
meter for use in monitoring meter health and calibrating the MC Synergy with the appropriate K-factor(s) and/
or meter factor(s).
Every NUFLO turbine meter and internals kit is packaged with a QR tag that contains calibration details and 
other information specific to the meter or internals kit. This record may be downloaded to a phone or tablet via 
a scan of the QR code, and then uploaded to the MC Synergy using the Sensia Digital Data Plate app. This 
process automatically populates this information in the K-Factor Entry settings in seconds and without the risk 
of human error that is ever-present with manual data entry.
However, if you prefer manual entry, you can enter the selections based on the calibration report supplied with 
your NUFLO turbine meter or internals kit.
1. Enter the K-factor turbine meter, K-factor, and meter factor settings as applicable.
2. Click OK in the top right corner of the screen to save the changes. 

TURBINE METER INFORMATION
Turbine meter information allows you to track the health of a specific turbine meter. Using this data, the MC 
Synergy monitors the flow signals and issues an alarm if it detects a bent blade, missing blade, erratic signal, 
and alerts you when the meter's internals are nearing the end of their expected functional life and are in need 
of replacement.

Note Uploading meter information to the MC Synergy via a phone scan of a turbine QR tag, facilitated 
by the Digital Data Plate app is the best way of preserving the accuracy of this information. How-
ever, if you are entering this information manually, take a few minutes to verify the following data 
to ensure its accuracy.

• Meter Part Number. The factory-issued number used to identify a specific group of design specifications.
• Internals Part Number. The factory-issued number used to identify the turbine internals kit that is 

periodically replaced to extend the functional life of a turbine meter.
• Brand. The commercial name used to uniquely identify the meter in the marketplace. "NUFLO" for 

example.
• Meter Serial Number. A traceable number issued at the time of manufacture to uniquely identify each 

meter certified by testers to meet minimum required specifications.
• Meter Range Units. Displays the units corresponding to the turbine meter range of values. To update, see 

Device Units, page 43.
• Flow Range - Min. Meter Range Low is the flow rate representing the minimum operating range of the 

meter. Values below this range will be outside the specified range of the meter and may not meet linearity 
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specifications. If the flow rate drops below this value for 2 minutes, a low flow warning will appear (see 
Suppressing Alarms, page 26).

• Flow Range - Max. Meter Range High is the flow rate representing the maximum operating range of 
the meter. Values above this range will be outside of the specified range of the meter and may not meet 
linearity specifications. Operating the meter above this value for extended periods may reduce the meter's 
life. If the flow rate rises above this value for 2 minutes, a high flow warning will appear (see Suppressing 
Alarms, page 26).

• Number of Blades. The number of blades in the turbine meter rotor. The device uses this parameter for 
monitoring turbine health. If the number of blades is entered in error, alarms will be triggered inadvertently 
(see Suppressing Alarms, page 26). Meter rotors may have 2, 3, 4, 6, 8, or 12 blades, depending on 
meter size and model. 

• Meter Body Diameter. Inside diameter of the turbine meter, measured in inches.
• Meter Kit Life. The time that will elapse before the turbine meter kit will need to be replaced, measured 

in days. When this user-specified period has elapsed, an alarm will trigger to alert you to replace the kit 
(see Suppressing Alarms, page 26). When you have replaced the meter kit, press the Reset Meter Kit 
Life  button to use the elapsed flow time for the previous kit as the replacement alarm trigger for the newly 
installed kit.

Figure 7.4—K-Factor Entry screen
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K-FACTOR SETTINGS
Use the calibration information provided with the turbine meter to enter the K-factor calibration. The default K-
factor is a linear K-factor set at 900 pulses per gallon. NuFlo meters are supplied with QR tags containing the 
calibration details. Alternatively, a calibration report (pdf) can be obtained from Sensia on request.

• K-Factor Units. Not Editable. Displays the units configured in Device Units, page 43.
• K-Factor Type. Linear or Multipoint. For each installed turbine meter, a factory calibration record specifies 

the K-factor for tested flow rate ranges or a uniform K-factor with a percent accuracy for a specified flow 
rate range.
 – Linear K-Factor. A single value which represents the volume that passes through the turbine meter for 

each pulse (Figure 7.5).
 – Multipoint K-Factor. Configurable as 2 points to 12 points (Figure 7.6). A number of points configured 

to represent the volume that passes through the turbine meter for each specified frequency. The MC 
Synergy will automatically interpolate for frequencies between configured points. 
 – Add Point. Presents a dialog for defining the K-factor at a specified frequency (Figure 7.7, page 

67).
 – Edit Point. Presents a dialog for changing the selected K-factor point (Figure 7.8, page 67).
 – You may also clear all K-factor points or delete a selected K-factor point from this dialog.
 – Sort Points. After entering the points, you can choose Sort Points to verify calibration. However, 

the points will be sorted automatically when the K-factor entry is saved.

Figure 7.5—Linear K-Factor

Figure 7.6—Multipoint K-Factor
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Figure 7.7—Add K-Factor Point dialog

Figure 7.8—Edit K-Factor Point dialog

METER FACTOR SETTINGS
As the turbine meter ages and its blades become worn, you may need to re-calibrate the MC Synergy to 
maintain the desired measurement accuracy. Instead of changing the K-factor, you may enter a meter factor. 
This should not be necessary with a new turbine meter, and so the meter factor is disabled by default.
Meter Factor Type. Linear or Multipoint Meter Factor. The meter factor is calculated by dividing the volume in-
dicated by a standard reference (from the calibrated K-factor) by the Indicated volume (measured) of the me-
ter. To determine if a multipoint meter factor is required, meter testing at varying frequencies may be required.

• Linear Meter Factor. A value which, when multiplied by the K-factor, equals the volume that passes 
through the turbine meter for each pulse.

Figure 7.9—Linear Meter Factor
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• Multipoint Meter Factor. Configurable as 2 points to 12 points (Figure 7.10). A number of points configured 
to be multiplied by the K-factor, resulting in the volume that passes through the turbine meter for each 
pulse at each specified frequency. The MC Synergy will automatically interpolate for frequencies between 
configured points.
 – Add Point. Presents a dialog for entering the Meter Factor at a specified frequency (Figure 7.11).
 – Edit Point. Presents a dialog for changing the selected Meter Factor point (Figure 7.12).
 – You may also clear all meter factor points or delete a selected meter factor point from this dialog.
 – Sort Points. After entering the points, you can choose Sort Points to verify calibration. However, the 

points will be sorted automatically when the meter factor entry is saved.

Figure 7.10—Multipoint Meter Factor

Figure 7.11—Add Meter Factor Point dialog

Figure 7.12—Edit Meter Factor Point dialog



69

NUFLO MC Synergy Software  Section 8

Section 8: Configure Outputs Settings
To configure output settings for an MC Synergy, select the Configure Device tile from the navigation menu and 
locate the Outputs settings in the submenu grid (Figure 8.1). 
If you are new to the MC Synergy interface, review Section 5: Configuration Basics, page 33 for an over-
view of configuration menus and methods. See also Section 6: Configure System Settings, page 43 and 
Section 7: Configure Turbine Settings, page 61.

Figure 8.1—Outputs configuration menus

ANALOG/HART OUTPUTS
These configuration settings allow you to set up a traditional 4 to 20 mA output or a HART protocol output. 
Both  outputs require the installation of an Analog Output/HART expansion board.

TRADITIONAL ANALOG OUTPUT
The settings in the Analog Output/HART screen can be used to configure a traditional 4 to 20 mA output even 
without HART communications. Simply make sure the HART Node selection is set to 4 to 20 mA Loop, and 
then jump to the Analog Output Settings in the middle of the screen to configure the low and high setpoints. 
See Analog Output Settings (4 to 20 mA Loop/Point-to-Point Only), page 73, for additional information.

HART OUTPUT
HART (Highway Addressable Remote Transducer) is a communication protocol that allows bi-directional com-
munication between HART-compliant devices. HART provides digital communication channels over a 4 to 20 
mA current loop. 
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The HART interface can be configured for either of two modes: Multidrop (Figure 8.2), or 4 to 20 mA Loop, 
also referred to as Point-To-Point (Figure 8.3, page 71). 

• If multiple HART devices will be added to the network, Multidrop must be selected. In Multidrop mode, the 
4 to 20 mA loop will be fixed at 4 mA. 

• If there is only one HART device on the network, the 4 to 20 mA Loop (Point-To-Point) may be chosen, 
and the user may retrieve the flow rate using an analog readout unit. 

Figure 8.2—HART Interface screen (Multidrop)
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Figure 8.3—HART Interface screen (4 to 20 mA Loop)
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HART Protocol Settings and Strings
The protocol settings and strings will vary, depending on the application, settings on the receiving device (i.e. 
handheld or modem), and established naming schemes. Contact your network administrator to ensure confor-
mity.

• Polling Address. Between 1 to 65535. The polling address is the destination address following the 38-bit 
scheme.

• Write Protected. Makes the configuration and information seen through HART “Read Only”.
• Password Code. A code containing 1 to 5 digits that is required to start receiving the data from the device.
• Request Preamble Count. 5 to 20 bytes. The number of bytes the receiving device is required to send for 

a command request.
• Response Preamble Count. 5 to 20 bytes. The number of bytes the MC Synergy is required to respond 

with to the receiving device.
• HART Message. Number of characters, up to 32.
• HART Descriptor. Number of characters, up to 16.
• HART Tag. A 16-character numbered tag for the specific device.
• HART Long Tag. A 16-character tag to describe the device.
• HART Meter Serial Number. The turbine meter serial number (7 digits).
• HART Tag Date. Numerical representation of the date of commissioning.

HART Measurement Units
The selected measurement units will be transmitted from the device to a HART handheld device or modem. 
These units are separate from the configured measurement and display units on the MC Synergy. Within the 
HART interface menu, the user may override the configured display units on the MC Synergy with the se-
lected HART measurement units.

• HART Rate Units. Flow rate units that are sent to the HART handheld device or modem via a unique code 
identifier. The selection includes the flow rate units and the unique code. This does not affect the settings 
on the MC Synergy for display or calculation. Options include:
 – gal/sec (22), gal/min (16), gal/hr (136), gal/day (235)
 – bbl/sec (132), bbl/min (133), bbl/hr (134), bbl/day (135)
 – m3/sec (28), m3/min (131), m3/hr (19), m3/day (29)
 – cf/sec (26), cf/min (15), cf/hr (130), cf/day (27)
 – L/sec (24), L/min (17), L/hr (138), L/day (240)

• HART Volume Units. Volume units that are sent to the HART handheld device or modem via a unique 
code identifier. The selection includes the volume units and the unique code. This does not affect the 
settings on the MC Synergy for display or calculation. Options include: 
 – gal (40)
 – bbl (46)
 – m3 (43)
 – cf (112)
 – L (41)

• HART Temperature Units. Temperature units that are sent to the HART handheld device or modem via a 
unique code identifier. The selection includes the temperature units and the unique code. This does not 
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affect the settings on the MC Synergy for display or calculation. Options include: °C (32), °F (33), K (35), 
and °R (34)

Analog Output Settings (4 to 20 mA Loop/Point-to-Point Only)
These settings are used to calibrate the analog output of the MC Synergy for sending the flow rate over the 4 
to 20 mA wiring. First, set the bounds of the high and low calibrations of the flow rate. Then, using the simulat-
ed value and the zero and full scale adjustment, you can “tune” the output to ensure that at the high flow rate, 
20 mA is being seen, and at the low flow rate, 4 mA is being seen.

• Enable Simulated Value. Turn the 4 to 20 mA simulated mode on or off.
• Simulated Value. This value is used under the simulated mode when it is enabled.
• Low Flow Rate (4 mA). This is the minimum flow rate for the process variable’s analog measurement. 
• High Flow Rate (20 mA). This is the maximum flow rate for the process variable’s analog measurement.

Note The rate units in parentheses next to the units for Simulated Value, Low Flow Rate, and High 
Flow Rate are the unit codes defined by the HART protocol.

• Analog Trim Offset. Not Editable. This is a product of the Calibrate Analog Output function in the Manage 
Device menu.

• Analog Trim Scale. Not Editable. This is a product of the Calibrate Analog Output function in the Manage 
Device menu.

HART Data Items
Use this list to select device variables to transmit over the wiring to the HART handheld unit or modem. Flow 
rate is fixed as the primary variable (PV) and this variable is not editable. You can choose three additional 
variables to transmit, which will be other totals that the device has logged. SV is item 2, TV is item 3, and QV 
is item 4.
To edit a Data item, click Edit HART Data Item and select a new total in the Device Variable Selection field 
(Figure 8.4, page 74). The options include: Grand Total, Daily Total, Hourly Total, Previous Day Total, Previ-
ous Hour Total, or Previous Polling Total.

Note The rate units displayed in parentheses in the Units column are the unit codes defined by the 
HART protocol.

You can also perform a reset as described below:

• Reset HART Data Item. Returns any variable other than flow rate (PV) to its default setting. By default,
 – SV (item 2) is Grand Total
 – TV (item 3) is Daily Total
 – QV (item 4) is Hourly Total

• Reset All HART Data Items. Returns all variables other than flow rate (PV) to their default settings.
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Figure 8.4— Edit HART Data Item

DIGITAL OUTPUTS
The Digital Outputs screen (Figure 8.5, page 75) allows configuration of the two MC Synergy digital out-
puts. By default, each digital output is disabled.
The user may configure each digital output as one of the following:

• Disabled.
• Specified Precision Pulse Output (MC-III Compatible). (Figure 8.6, page 75) Each pulse represents a  

specified increment of volume in the units selected for Total Volume Display in Device Units.
• Scaled Pulse Output. (Figure 8.7, page 76) Each pulse represents a user-configured volume in the 

user-selected units.
• Status Output. (Figure 8.8, page 77) This setting logs an output each time an alarm trigger condition 

occurs.
• Amplified Raw Output. (Figure 8.9, page 78) This setting gives an amplified square wave 

representation of the raw incoming turbine meter signal received by the MC Synergy.
• Modbus Register Control. (Figure 8.10, page 79) This setting allows the digital output to be controlled 

via Modbus, where a value of “0” will give the normal output state, and “1” will give the activated state
 – For NC, “0” is closed, and “1” is open. 
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– For NO, “0” is open, and “1” is closed.

You can use Modbus register 4108 to control Digital Output 1, and Modbus register 4121 to control 
Digital Output 2.

Figure 8.5—Digital Outputs screen (outputs disabled) 

SPECIFIED PRECISION PULSE OUTPUT (MC-III COMPATIBLE)
This output sends the defined signals to represent increments in volume. The number of pulses in the output 
is proportional to the volume accumulated from the incoming turbine signal. Each pulse represents a specified 
increment of volume in the units selected for Total Turbine Volume. 

Figure 8.6—Specified Precision Pulse Output screen
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• Volume Per Pulse. The volume that passes through the meter for each pulse generated. To configure the 
volume unit, see Device Units, page 43.

• Pulse Duration. In the Pulse Duration field, enter a value in multiples of 10 milliseconds. The Pulse 
Duration determines the length of the active portion of each output pulse.

• Output State. The pulse output can be either Normally Open or Normally Closed. The output state of 
a digital output is reported as Active or Not Active. When not active, the output switch is in the user-
configured normal position (i.e. Normally Open or Normally Closed).

• Normally Open. The output will close on each pulse for the duration specified in the Pulse Duration field.
• Normally Closed. The output will open on each pulse for the duration specified in the Pulse Duration field.

SCALED PULSE OUTPUT
This output sends one pulse for each whole number derived from taking the value of the selected register and 
dividing it by the scale factor. The number of pulses in the output is proportional to the volume accumulated 
from the incoming turbine signal. Each pulse represents a user-configured amount of volume, and the unit of 
the volume is user-defined from the software.

Figure 8.7—Scaled Pulse Output screen

• Volume Units. The volume units for which the meter has been calibrated.
• Volume Per Pulse. The volume that passes through the meter for each pulse generated.
• Pulse Duration. In the Pulse Duration field, enter a value in milliseconds. The Pulse Duration determines 

the length of the active portion of each output pulse.
• Output State. The pulse output can be either Normally Open or Normally Closed. The output state of 

a digital output is reported as Active or Not Active. When not active, the output switch is in the user-
configured normal position (i.e. Normally Open or Normally Closed).
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 – Normally Open. The output will close on each pulse for the duration specified in the Pulse Duration 
field.

 – Normally Closed. The output will open on each pulse for the duration specified in the Pulse Duration 
field.

STATUS OUTPUT
This setting logs an output each time an alarm trigger condition occurs.

Figure 8.8—Status Output screen

• Alarm Conditions. For each alarm, select all the alarms that will require the digital output. For example, 
one alarm may be set to alert you via a light or audible device, and the other may be wired for an 
emergency shutdown if one or more catastrophic conditions are detected.

• Trigger Mode. Configure the output to activate for each alarm, or only when all the selected alarms in 
Alarm Conditions are activated.
 – Any Selected Alarm. The pulse output will activate if any of the selected alarms being triggered.
 – All Selected Alarms. The pulse output will only activate when every selected alarm has been 

triggered.



78

Section 8 NUFLO MC Synergy Software

• Output Latching. Configure the status output to either activate/deactivate based upon the combination of 
the Alarm Conditions and Trigger Mode, or to activate and remain activated when the status pulse output 
is activated.
 – Non-Latching. The output will return to an inactive state when the assigned register value returns to a 

normal range (and the selected alarms are no longer triggered) without intervention from the operator.
 – Latching. The output will remain in an active state once it is activated, even if the assigned register 

value returns to a normal range (and the selected alarms are no longer triggered).

Note If the digital output is being used for a turbine health alarm, a latched output is recommended. 

• Output State. The output state of a digital output is reported as Active or Not Active. When not active, the 
output switch is in the user-configured normal position (Normally Open or Normally Closed).
 – Normally Open. The output will close on each pulse for the duration specified in the Pulse Duration 

field.
 – Normally Closed. The output will open on each pulse for the duration specified in the Pulse Duration 

field.
• Enable Alarm Records Generation. Configure a status output to also trigger an alarm archive record to be 

generated for the selected alarms.

AMPLIFIED RAW OUTPUT
This output gives an amplified square wave representation of the raw incoming turbine meter signal received 
by the MC Synergy.

Figure 8.9—Amplified Raw Output screen

The Amplified raw output signal can be set for a Normally Open or Normally Closed State. 

• Normally Open. The output will close on each pulse.
• Normally Closed. The output will open on each pulse.
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MODBUS REGISTER CONTROL OUTPUT
This output allows the digital output to be controlled via Modbus, where a value of “0” will give the normal out-
put state, and “1” will give the activated state. For example:

• For NC-Normally Closed, “0” is closed, and “1” is open.
• For NO-Normally Open, “0” is open, and “1” is closed. 

You can use Modbus register 4108 to control Digital Output 1, and Modbus register 4121 to control Digital 
Output 2.

Figure 8.10—Modbus Register Control screen

• Output State. The pulse output can be either Normally Open or Normally Closed. The Output State of 
a digital output is reported as Active or Not Active. When not active, the output switch is in the user-
configured normal position (i.e. Normally Open or Normally Closed).
 – Normally Open. The output will close on each pulse for the duration specified in the Pulse Duration 

field.
 – Normally Closed. The output will open on each pulse for the duration specified in the Pulse Duration 

field.
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Section 9: Download Archives
The Download Archives menu (Figure 9.1) allows you to download archive records stored in the device. You 
can customize the download process using configurable settings in the Download Archives menu and in the 
Options dialogs accessed via the Tools menu at the top of the screen. You may choose to automate the file 
naming scheme for each archive download, or have the program prompt you for a file name after each down-
load.

Figure 9.1—Download Archives screen

FILE NAME AND FILE PATH CONFIGURATION
By default, the MC Synergy stores archive download files in this location on your hard drive: C:\Sensia Data\
NuFlo MC Synergy Interface. The Tools>Options menu gives you the tools to change and/or append this file 
path to group your downloads in subfolders that are most meaningful to you. 
To take advantage of automatic file names, you will first need to establish the rules to be applied in defining 
the information you want to capture in your archive filenames using the Tools>Options dialogs. Complete in-
structions are provided in Section 11: Interface Options, page 93. 
Once the rules are established, choose Automatic Data File Naming Rules from the Download Archives 
screen to apply this feature. The space on the right side of your screen will show a preview of your automated 
file path and filename (Figure 9.1).
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If you prefer to enter your own file path and filename for a download, choose Prompt For File Name. When 
the download completes, a dialog will appear prompting you for a file name and storage location (Figure 9.2).

Figure 9.2—File name prompt option for archive downloads

INITIATE A DOWNLOAD
To initiate the archive download, 
1. Click Download Archive Data. The download will take several seconds to complete. A progress bar will 

display both in the navigation window at the top of the screen and in the footer of the screen, and a text 
notification will appear on screen to provide a real time indication of the percentage of data read (Figure 
9.3, page 83). 

2. Click OK to acknowledge the confirmation dialog upon completion of the archive data transfer (Figure 
9.4, page 83). The resulting file will have a proprietary .sdf format, readable only with Sensia ScanData 
software.  
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Figure 9.3—Download progress display

Figure 9.4—Downloaded archive file (SDF)

ANALYZING ARCHIVE DATA
ScanData, a complimentary Sensia software program, allows you to view archive data in a tabular format 
(Figure 9.5, page 84) or graphical (trend) format (Figure 9.6, page 84). Device configuration, current flow 
conditions, alarms, events, and calibration data can all be viewed, analyzed, and exported in a read-only for-
mat for sharing with others.
To open an archive download (SDF) file, download the ScanData software from the Sensia website and install 
the software on your PC or laptop. Reference the ScanData User Manual (embedded in the Help menu) to 
open and configure the software to your viewing preferences.



84

Section 9 NUFLO MC Synergy Software

Figure 9.5—ScanData tabular view of MC Synergy archive data

Figure 9.6—ScanData trend view of MC Synergy archive data



85

NUFLO MC Synergy Software  Section 10

Section 10: Manage Device
The Manage Device menu (Figure 10.1) provides access to a variety of discrete operations that can be per-
formed on the MC Synergy in addition to the configuration procedures described in previous sections.

Important If your device has been configured previously, it is advised to save the configuration before per-
forming any new operation that could change the configuration unexpectedly. See Configuring a 
Connected Device, page 34 and Configuring a Device Offline, page 35 for details.

 
Figure 10.1—Manage Device screen
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CONFIGURATION UPLOAD
The Upload From SRF File button on the Manage Device screen allows you to load a previously saved con-
figuration (SRF) into your MC Synergy.
This function differs from the Import from SRF File option in the Configure Device menu as follows:

• The Import from SRF File function adds selected data sections to your working configuration file.
• The Upload from SRF File function behaves more like a configuration wizard, allowing you to upload 

selected data sections from a saved configuration file, and override settings where applicable to  
customize the configuration to a specific device. This method is ideal for uploading a configuration to 
multiple devices. Setting types available for override include: 
 – Device identification overrides
 – Ethernet overrides
 – Serial port overrides

The software will present a snapshot of your selections for your review before you execute the upload. On 
execution, the PC software will disconnect from your device and prompt you to reconnect to put the new 
settings into effect. 

Note Always save the current configuration before loading a new configuration from an SRF File. If 
you do not, your original settings, configuration, and calibration will be lost. 

To upload configuration settings from an SRF file:
1. Click the Upload From SRF File button (Figure 10.1, page 85) and select an SRF file from the dialog 

supplied (Figure 10.2, page 87).
2. Select individual data sections to include in the upload, or click the Select All link in the top right corner to 

upload the entire content of the SRF configuration file (Figure 10.3, page 87).
3. Review and edit the override settings in subsequent screens.
4. Verify your selections in the final Review summary and click OK to execute the upload (Figure 10.4, page 

88).
5. The PC software will temporarily disconnect from the device and prompt you to reconnect to load the new  

uploaded configuration.
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Figure 10.2—Upload file selection

   
Figure 10.3—Selection of data sections and overrides to be included in upload
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Figure 10.4—Review summary for verification before upload is executed
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DEVICE COMMANDS
Device commands (Figure 10.5) allow you to perform a variety of operations on the MC Synergy. These op-
erations may also be performed over Modbus via the command registers presented in the MC Synergy Hard-
ware User Manual.

Figure 10.5—Device Commands

Operations supported by this menu include:

• Sync Device Clock. Sets the MC Synergy to the same date and time as the connected computer. It is 
important to ensure that the computer date is correct, and the computer time has been set to the correct 
time zone.

• Sync Device Clock with Offset. If the computer is remote, you can use this feature to offset the MC 
Synergy clock to the difference in hours from the remote site to the MC Synergy.

• Clear Unacknowledged Alarms. Will clear all alarms and reset digital outputs if latched. If an alarm 
condition is still present, then the alarm will reactivate again.

• Reset Grand Total. Resets the accumulated grand total to zero. This will not affect the archived logs, but 
only the grand total value stored in the device registers.

• Create Partial Records. If desired, you can manually create an archive record (daily or interval). This can 
be useful for starting a new record, which may be especially helpful if you have made changes to the 
device configuration that would affect measurement (changing a meter factor or K-factor, for example). 

• Reset Port Stats. Clears the current statistics for Port 1 and 2, to allow the user to start a new period of 
monitoring communication. This is useful if a device stops working, and current port statistics are needed 
for debugging the communication.

• Load Defaults. Automatically reverts data values and units to factory default settings (Figure 10.6, page 
90). By default, all default categories are included. However, you can individually select which of three 
functional groups you wish to return to default settings. As a best practice, always save your current 
configuration before loading defaults so that you have the option of restoring settings later, if desired.



90

Section 10 NUFLO MC Synergy Software

• Reset Meter Kit Life. If a meter is to be installed, then the user may use this button to reset the meter life. 
When this is done the device will automatically set meter life using the time elapsed for the last meter. The 
intent is to ensure a regular maintenance schedule.

Figure 10.6—Load Defaults selections

OUTPUT CALIBRATION
If you are using the MC Synergy to configure a 4 to 20 mA output, the Analog Output Calibration tool (Figure 
10.7, page 91) will allow you to set the analog trim offset and scale to calibrate the output. 
Connect your device to a current readout device prior to beginning this calibration, and follow the on-screen 
instructions, step by step.
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Figure 10.7—Analog output calibration tool

Important If you close the dialog before the final step of calibration, the calibration will be in an indetermi-
nate state. At the prompt, use the Reset Analog Output Calibration command to reset the cali-
bration to default values, and then restart the calibration procedure (Figure 10.8).

Figure 10.8—Reset Analog Output Calibration prompt

DEVICE FIRMWARE UPDATE
To maximize your MC Synergy's performance and take advantage of the latest enhancements, you should 
update the firmware for your device as updates become available. Firmware updates often introduce new fea-
tures and can make the device more immune to errors or malfunctions.

Note Each firmware update includes release notes, updated Modbus maps, and a binary firmware file 
(.bin). Before updating the firmware, always read the release notes to verify that the change will 
not disrupt the expected operation of the MC Synergy. 
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• Upload Firmware Image. This operation is used to select the MC Synergy firmware file. The software 
will validate the firmware's compatibility with the connected device. For example, the software will reject 
the firmware if it does not have the same Register Table version, as this could cause a mismatch in the 
register addresses.

• Activate Stored Firmware. Once the firmware is verified, you can activate it on the device.
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Section 11: Interface Options
Supplementing the configuration settings in the MC Synergy navigation menu is a group of optional settings  
that lets you fine-tune your user experience. You can change default settings to save steps in accessing the 
settings you use most often, change communications settings to aid in troubleshooting, and set up rules for 
auto-naming and storing your archive files, for example.
These configurable settings are organized within four option groups, as shown in the left column of Figure 
11.1. Each of this settings is explained in detail in this section.

Figure 11.1—Interface Options, General Option Group

Upon making changes to these user settings, click OK at the bottom of each screen to save your changes.
If you decide the changes you made in an Interface Options screen are no longer desired, click the link in the 
lower left corner of each screen to reset all user settings to default settings (Figure 11.2, page 94).
These changes will be effective upon the next connection to the device.
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GENERAL SETTINGS

Figure 11.2—Interface Options reset to default link

CLOCK SYNCHRONIZATION THRESHOLD
Each time the PC software connects to the MC Synergy device, it reads the current time in the device real 
time clock and compares it to the time in the user’s PC. If the time difference is greater than the value in the 
threshold, you will receive a prompt asking to synchronize the time with the PC. 
By default, this threshold is set to 7 seconds. If you do not wish to support daylight savings changes, set this 
value to a number greater than 3600 seconds (1 hour). You can set the threshold to any number between 1 
and 86,400 seconds (1 day). 

CHANGE DEFAULT CONNECTION METHOD
This setting determines the preferred / default Connection method. 
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CHANGE DEFAULT CONFIGURATION FILE ACCESS METHOD
This setting is used to choose a preferred file access method selection when creating or editing a file offline 
using the Edit Configuration File menu selection on the software home page.

DEFAULT LOCATION FOR SAVED CONFIGURATION (SRF) FILES 
Choose a default location for configuration files created offline using the Edit Configuration File menu.  Once 
the file is ready to be saved, you can save the .SRF file in this default location. Alternatively, you can select a 
different folder location.

INCREASE ACCESS TO RECENTLY USED FILES/CONNECTIONS
This setting specifies the number files / number of connections to show in the Recent Files dialog and the Re-
cent Connections dialog. You can select between 5 and 15 files / connections to show. 

RESET ALL USER SETTINGS TO DEFAULTS
This link will reset all settings within the MC Synergy Interface Options dialog to their default values (not just 
the settings on the page in view). Click OK to save and apply the default settings and close the dialog, or click 
Cancel to abort the reset function and return the settings to their previous values.
Do not confuse this with the procedure for instantaneously deleting the user settings file. See Delete User 
Settings File, page 102, for details. 
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COMMUNICATION SETTINGS

Figure 11.3—Interface Options, Communications Option Group

TOGGLE RTS LINE FOR RS-485 ADAPTER TRANSMIT CONTROL
Some USB to RS-485 converters may use the RTS signal from the PC to toggle the transmit functionality of 
the RS-485 converter. Enable this setting for use with the NuFlo USB. Enabling this setting may also help re-
solve communication stability issues observed with other USB to RS485 converters.

PRESEND DELAY
This setting is the number of milliseconds that the PC program will delay prior to starting communications with 
the MC Synergy on each message. For best results, keep this value as low as possible. The range of entry is 
10 msec to 5000 msec. In some cases, such as connections using radio that require a warm-up period, you 
may need to increase this value.  



97

NUFLO MC Synergy Software  Section 11

DEVICE COMMAND TIMEOUT
This setting is the number of milliseconds that the PC program will wait for a response from the MC Synergy 
before determining that the last message being sent was unsuccessful. Normally, the MC Synergy responds 
very quickly. The default value for this setting (5000 msec) is recommended. This setting will accept a value 
range from 1000 msec to 20000 msec. 

DEVICE COMMAND RETRIES
This setting provides additional retries in the event of a communication failure with the MC Synergy during 
top-level operations like “Read Configuration”, “Reading Real Time Data”, and “Downloading Archives”. Start 
with the default setting of 5 retries. This setting will accept a value from 0 to 10. 

MULTI-STAGE OPERATION RETRIES
This setting provides additional retries in the event of a communication failure with the MC Synergy during 
lower-level operations such as “ Initiate Send”, “Range Send”,  or  “Packet Send”.   Start with the default set-
ting of 2 retries. This setting will accept a value from 0 to 10.

USE PACKET STREAMING MODE IN DEVICE COMMUNICATIONS
Packet streaming mode is enable to optimize communications between the MC Synergy and the PC Inter-
face.  This setting is on by default. If you are experiencing communication instability and timeouts, disabling 
this setting may help. 
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ARCHIVE DATA SETTINGS

Figure 11.4—Interface Options, Archive Data Group

DEFAULT ARCHIVE LOCATION
This setting establishes the default location for storing downloaded archive files (.SDF). Changing this setting 
to the file path of your choice may eliminate the need to change the file path at each download and will ensure 
that all downloads are stored consistently in the location of your choosing.

AUTOMATING FILE PATH AND FILE NAMES
Taking a few minutes to customize the file names and file path used for your archive downloads can save you 
time during downloads and provide consistent file naming to simplify the process of locating the files later. 
Automatic Data File Naming is one of the options presented to you when you click the Download Archives 
menu. When you select it, you are applying the filename and file path rules established in this Option setting 
procedure.
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Select Tools>Options from the menu bar at the top of the screen and choose Archive Data from the Option 
Groups in the left column to get started.

Automating the Storage Path
By default, the MC Synergy will store all archive download files in this location on your hard drive: C:\Sensia 
Data\NuFlo MC Synergy Interface. The Tools>Options menu gives you the tools to change and/or append this 
file path to group your downloads in subfolders that are most meaningful to you.
1. To change the default location, simply click the folder icon and create and/or select the folder you wish to 

use. Then click OK to save the changes.
2. To customize the grouping of downloads by a unique descriptor such as well name, lease name, or loca-

tion name, use the Add and Remove buttons in the File Storage Path Naming dropdown menu to select 
the descriptors you want included in the storage path. You can include as many as you would like and 
they will be populated in the order you enter them in the Selected Folder Naming Items list. Move Up and 
Move Down buttons help you reorder items as necessary. 

Note The field names shown in Figure 11.4, page 98 will be replaced by actual company/well/lease/
location names as configured in the Device Identification settings (Figure 11.5, page 100).  

4. Verify the file path in the preview provided at the bottom of the screen.
5. Click OK to save your changes. They will be applied at the next device connection.

Automating the Download File Name
By default, the MC Synergy assigns the prefix ArchiveData and a date/time stamp to each download filename: 
ArchiveData_<YYYYMMDD>_<HRMMSS>. The Tools>Options menu gives you the tools to change and/or 
append this filename structure to remove or replace the prefix, remove the date/time stamp, and add unique 
descriptors such as well name, lease name, or location name to make them easier to identify.
To customize the filenames automatically applied to archive downloads, 
1. Use the Add and Remove buttons in the Archive Data File Naming dropdown menu to select the descrip-

tors you want included in the filename. You can include as many as you would like and they will be popu-
lated in the order you enter them in the Selected File Naming Items list. Move Up and Move Down buttons 
help you reorder items as necessary. 

Note The field names shown in Figure 11.4, page 98 will be replaced by actual company/well/lease/
location names as configured in the Device Identification settings (Figure 11.5, page 100).  

3. Enable or disable the prefix option and enter a custom prefix if applicable.
4. Enable or disable the timestamp. 
5. Verify the file path in the preview provided at the bottom of the screen.
6. Click OK to save your changes. They will be applied at the next device connection.
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File Name Example

Figure 11.5—Device identification tags used in rules for automatic file name convention 

Figure 11.6—Sample result of automatic file name
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DEVELOPER SETTINGS

Figure 11.7—Interface Options, Developer Group

GENERATE DEBUG OUTPUT FILES 
When checked, this setting creates multiple debug files that may be requested by Sensia support personnel 
to assist in software interface issues or communication issues. 

LOCATION FOR DEBUG LOG FILES
This specifies the location of the debug log files. The debug log files are relevant for the most recent session 
and may be overwritten if the program closes and is later reopened. It may be necessary to make a copy of 
the files prior to restarting the program. 
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DELETE USER SETTINGS FILE 
This link deletes all user settings from the Option Groups. When you click the link, you will be prompted to 
close the Option dialog. When the Option dialog reopens, default values will be applied and your previous 
user settings will be deleted and unrecoverable. Under normal operations, this file should be deleted only as a 
last resort. 
If you suspect your software install may have become corrupted, first try resetting Interface Options settings 
by clicking the “Reset all user settings to defaults” link at the bottom of the Interface Options screens (Figure 
11.2, page 94).

CREATE DEFAULT DIRECTORIES
Should the file paths to the directories you created for debug files become corrupt or unreliable, this tool will 
recreate the directories. 
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Appendix A—Troubleshooting Serial Communications
When the MC Synergy is connected properly with an RS-485 adapter, communication errors should be rare. 
Depending upon your timeout settings, the layout of your wiring, or even the processing load on your Win-
dows operating system, you may experience the occasional communication error. To resume operations, click 
OK in the Communications Problem dialog box, then perform a refresh from the software screen. 
However, if you experience consistent communication errors, further troubleshooting may be required to de-
termine the source of the problem. 
Review the following list of some commonly reported problems and solutions. If you cannot resolve the prob-
lem after trying these solutions, contact Sensia Technical Support. Please make a note of all troubleshooting 
steps attempted and the results, and be prepared to discuss this information with a technician.

EXPRESS CONNECT PROBLEMS 
Express Connect allows the program to detect the MC Synergy regardless of the device's baud rate and slave 
address settings. If you are not able to connect, try the Specify Parameters method to specify the slave ad-
dress and baud rate. Express Connect is not recommended for connecting to multiple instruments. 

MULTIPLE DEVICE NETWORKS
The Express Connect method is not recommended for connecting to multiple instruments. For multi-device 
networks, use the Specify Parameters connection method. Each MC Synergy in the network must have a 
unique slave address.

BAD CONNECTION
Check to ensure connections are secure between your computer and your RS-485 adapter, and between your 
adapter and the MC Synergy. Also, confirm the polarity of the wiring from the converter to the instrument. For 
more information on wiring the converter, refer to the MC Synergy QuickStart Guide or the MC Synergy Hard-
ware User Manual. 

NUFLO USB DRIVER ISSUES
If the MC Synergy is equipped with a NuFlo USB Adapter but it does not appear as a serial port selection in 
the MC Synergy software, verify that the NuFlo USB driver is installed correctly. From your computer, go to 
Device Manager, navigate to Ports (COM & LPT) and expand the selection. If the adapter is properly installed, 
it should appear without a yellow exclamation mark. If the adapter appears with a yellow exclamation mark, 
your computer has detected the adapter but there is some issue with connectivity. Check for a conflict with the 
port number. If that is not the problem, try removing the driver and re-installing it.

POWER PROBLEM 
Check that the MC Synergy is receiving adequate power and that the power connections are secure. Verify 
that the LCD display is illuminated and press the INC button on the keypad to test the display sequence, 
which includes a voltage display.

TIMEOUT PERIOD IS TOO SHORT 
Depending on your computer's hardware and software characteristics, and the characteristics of your device 
network, the default timeout periods may be too short. To extend the timeout period, choose Tools>Options 
from the software menu bar. Then choose Communications from the Option Groups menu, and adjust the set-
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ting for Device Command Timeout. By default, the timeout is 5000 msec. It can be set to any value between 
1000 and 20000 msec.  
The timeout period does not directly affect the time required for the device to respond. It only affects the 
length of time the program will wait for a response before giving up and reporting an error. If you specify a 
long timeout period, you will wait longer for the program to return control to you when communication errors 
occur.

LINE NOISE
Line noise can be the problem when you are unable to connect or experience intermittent communication er-
rors, communication retries, CRC errors, or framing errors. Check that your RS-485 wiring is not routed near 
sources of electrical noise, such as electric motors. If minor line noise cannot be avoided, try lowering the 
baud rate of the device and/or increasing the number of retries (as described below in Not Enough Retries).  

NOT ENOUGH RETRIES
If the program does not receive a valid response from the device within the specified timeout period, the 
program will automatically resend the message a number of times before finally reporting a communications 
error. Line noise can corrupt messages exchanged between the program and the device, and increasing the 
number of retries can improve the chance for a successful connection. 
To change the number of retries, choose Tools>Options from the software menu bar. Then choose Communi-
cations from the Option Groups menu, and adjust the setting for Device Command Retries and/or Multi-Stage 
Operation Retries. 
By default, the number of Device Command Retries is 5 and the number of Multi-Stage Operation Retries is 
2. Both settings can be set to any value between 0 and 10.  

• Device Command Retries is for top-level operations like "Read Configuration", "Read Real Time Data", 
and "Download Archives." By default, it is set to 5. It can be adjusted to any value between 0 and 10.

• Multi-Stage Operation Retries is for lower-level operations such as "Initial Send", "Range Send", or "Package 
Send". By default, it is set to 2. It can be adjusted to any value between 0 and 10.

Setting a high number of retries will not directly affect communication speed when there is a good connection, 
since there would be very few actual retries. However, setting a high number of retries will result in longer 
waits for the program to return and report an error when there are communications difficulties.

SPECIFIC BAUD RATE REQUIRED
If you are using a radio link, a virtual COM port, or an Ethernet serial converter, ensure that the baud rate set 
in the device is supported by the intermediate link. 

BAUD RATE IS TOO HIGH 
If you have a long wiring network, have many devices on your network, or have line noise, try a slower baud 
rate to achieve reliable communication among your devices.

DEVICE BUS DELAY IS TOO SHORT 
The bus delay setting may be the problem when you do not receive a reply from your device, or you experi-
ence many retries.
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If you are able to connect to the device, increase the time that the MC Synergy waits before responding to 
Modbus commands by increasing the Bus Delay value in the device. You do not need to adjust the program's 
timeout periods to account for the Bus Delay. This is done automatically by the software.
If you are experiencing a problem on one port, try the other port.
In cases of consistent timeouts, it may be helpful to slow the MC Synergy’s message response rate by in-
creasing the Bus Delay in the device to at least 50 msec to prevent the response from being missed by the 
software. The default Bus Delay is 10 msec.

PRESEND DELAY IS TOO SHORT 
Increase the time that the program waits between consecutive Modbus commands by increasing the Presend 
Delay value. To locate this setting, choose Tools>Options from the software menu bar. Then choose Commu-
nications from the Option Groups menu, and adjust the setting for Presend Delay. By default, the setting is 10 
msec. It can be set to any value between 10 and 5000 msec.  

DEVICE PARAMETERS CHANGED WHILE CONNECTED 
If you manually change the MC Synergy communications parameters (slave address or baud rate) from the 
instrument keypad, the software program will not detect the change. Return to the Home Screen and recon-
nect to the device. 

RTS CONTROL IS NOT PROPERLY SET 
Your RS-485 adapter may require that the RTS line of the COM port be toggled to control the direction of data 
flow for transmit and receive. If so, ensure that the "Toggle RTS line" option is enabled. To access this setting,  
choose Tools>Options from the software menu bar. Then choose Communications from the Option Groups 
menu. Check the Toggle RTS line option to enable it.
Alternatively, if your device COM port is connected to a modem device that requires the RTS line to be used 
in the standard way for RS-232 flow control, uncheck the Toggle RTS line checkbox to disable this feature. 

SPONTANEOUS LOSS OF COMMUNICATION 
If the program stops communicating with the MC Synergy while you are using the program for some unknown 
reason, return to the Welcome Screen and reconnect. 

CORRUPT SETTINGS 
If the settings in the MC Synergy become corrupted or are changed in such a way that the device fails to 
communicate with the software, load factory defaults from the keypad as described in the MC Synergy Hard-
ware User Manual. The device will load factory default settings and show "DEFAULTS LOADED" on the LCD 
briefly. 

CAUTION
Loading factory default values will replace all configuration values. However, logged data will 
remain intact.

SOFTWARE ERROR 
An unexpected software error may interfere with communications. Close the program and run it again. If the 
problem persists, close all programs and restart your computer.
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WINDOWS IS TOO BUSY 
If you are running a large number of programs or a few CPU-intensive programs at the same time as the MC 
Synergy program, the processing load on Windows may cause delays in serial port processing. When this 
happens, the program is not receiving data from the COM port fast enough, so even though data was trans-
mitted by the device in time, timeouts can occur. Reduce the load on Windows by closing some of the other 
programs.
Switching between programs also increases the operating system load by causing Windows to perform vari-
ous system activities. If you navigate to another program while the MC Synergy software is busy communicat-
ing with the device, it may cause a delay in Windows delivering data from the serial port to the program. 
Also, when the MC Synergy software is running in the background, it receives a smaller percentage of the 
CPU's processing time, and will run more slowly. If the program is completing a communication-intensive op-
eration, this reduction in processing power may cause communication problems. If you notice problems when 
you switch away from the MC Synergy program, close other programs or keep the MC Synergy program in 
the foreground while it is being used.
Systems with faster CPUs and more memory will be less likely to experience these types of problems. 
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